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/ntrodƵction
This Initiation Booklet is specifically developed towards a particular skill set and qualification for 
participants undertaking the aforesaid training.

Module objectives are as follows: 

• Understanding Editing and its Process

• Editing software’s and learn their techniques

• Innovative editing methods.

• Adding effects and enhancing Editing

• Team Management of Subordinates

• Health, Safety and Security Standards
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<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
The completion of the module will enable:

1. Explain the importance of media and entertainment sector in our life.

2. Describe role and responsibility of Editor.

3. Familiarized with the technical terms associated animation.



3

Editor

hnit KbũĞctiǀĞƐ 

hE/d ϭ͘ϭ͗ /ntrodƵction to DĞdia and �ntĞrtainŵĞnt ^Ğctor 

The completion of this unit will enable:

1. Explain the importance of media and entertainment sector in our life.

2. Describe role and responsibility of Editor.

ϭ͘ϭ͘ϭ DĞdia and �ntĞrtainŵĞnt ^Ğctor in /ndia

ϭ͘ϭ͘Ϯ �ŵpůoǇabiůitǇ in DĞdia and �ntĞrtainŵĞnt ^Ğctor 
The performance, growth and profits of media and entertainment industry depends on the economic structure 
of the country. The progressive support states to increase employment opportunities to 1.3 million by 2022 from 
0.4 million in 2013.

The Film Industry accommodates the highest workforce in the above statistic at 25%. 

In today’s Digitalisation Era, the last decade has seen a massive development in Indian Media and Entertainment 
Industry. Growing Rapidly at 13.9 % CAGR and contributing to 1.7 % GDP supported by the increasing popularity 
of digital advertising which churns a whopping INR 4.14 Billion every year and more celebrating its position by 
being 14th largest industry in the world.

Fig.1.1.1: Advertising Revenues for TV Industry

This Sector is one of the strong industries supporting the Indian Economy by having over 700 Television Channels 
and over 200 FM Stations, Constituting to the largest production houses globally and leading the film industry 
internationally.

The Media and Entertainment Industry is sustainably growing with a support of the Indian Government that 
consciously takes initiatives like providing institutional finance to film industry, digitalizing cable network and 
recent increase of FDI limit to 100% in DTH and Cable Parameters. 

Today, This industries Employment is at 14% to the country. 
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^Ƶb ^Ğctor �ŵpůoǇŵĞnt ;in DiůůionƐͿ

2 0 1 3 2 0 1 7 2 0 2 2

Television 0.14 0.28 0.64

Print 0.06 0.07 0.13

Radio 0.02 0.03 0.04

Animation, VFX and 
Gaming

0.02 0.03 0.04

Films 0.16 0.24 0.44

Overall Sector 0.4 0.65 1.3

ϭ͘ϭ͘ϯ �ǀoůƵtion oĨ DĞdia and �ntĞrtainŵĞnt ^Ğctor

Fig.1.1.2: Media and Entertainment Employment 
in 2013

Fig.1.1.3: Employement in Different Sectors of Media and Entertainment

•	 The film industry of India accommodates the highest workforce 
in the above statistics at 25%.

•	 The media and entertainment industry has many niche sectors 
tgat demand skilled labour, currently CAGR is recorded at 13% 
but projected to grow with 1% increase comprising of 1786 
billion within a year.

•	 The highest employers remain the Film and Television sectors 
attracting employees from various walks and classes. The variety 
of channels and sub stations keep attracting workforce caused 
by rapid digitization.

•	 The initial start into entertainment was with Satellite Broadcasting over sound alone, bringing Radio into 
action in India with the Radio Club commencing in 1923 while the Britishers ruled us.

•	 The most connected medium and the influential one since British Raaj was the All India Radio that started 
operations in 1936

•	  DD Network, the beloved Doordarshan Started television operations in 1959, September 15th 

•	 The Indian economy was closed until 1990, and no private player was allowed to enter the space In the 
1990s, the Indian film industry was completely fragmented

•	 BBC launched its national service in 1995

•	 The Indian government began licensing private companies to start their own radio stations on Indian            
Broadcasting 

•	  In May 2000, as part of Phase I of radio broadcast licensing, the auction was conducted and 37 licenses were 
issued, out of which 21 are operational in 14 cities.
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ϭ͘ϭ͘ϰ Daũor ^ƵbƐĞctor and ^ĞŐŵĞntƐ

Fig.1.1.4: Media and Entertainment Sector

Fig.1.1.5: Media and Entertainment Sector Growth Rates in 2013

•	 The Indian M&E industry comprises several sub-sectors, such as television, radio, print media (including 
newspapers and magazines), films, music, and animation and visual effects (VFX).

•	 Advertising plays a crucial role in sustaining the performance of media and entertainment industry, as the 
revenue collected with advertising mediums supports and grows the overall economy.

•	 The industry does not rely so much on foreign materials and produces most equipment, appliances and 
systems in house. A minor portion of exports may include antennas, cables and satellite boxes.

•	 The industry is specific to cultural and ethnic backgrounds, and is organized around specific hubs that 
specialize in output for a given population segment. For example, the Mumbai film industry (Bollywood) is a 
key film hub in the country. A similar hub also exists in South India.
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ϭ͘ϭ͘ϱ ZoůĞ oĨ an �ditor
ZoůĞ 

The respected person is required to reassembled, uncut, merge and comprehend music, sound, images and 
production footage into a broadcast usable sequence.  

�orĞ coŵpĞtĞncǇ 

The individual should be competent with techniques in editing like sorting, splicing, joining, merging, synchronizing 
and assembling using editing software’s like Avid, Final Cut Pro, After Effects, Adobe and Sound Software.

PrĞrĞƋƵiƐitĞƐ 

•	 They should have a working knowledge of computer and operating system.

•	 Working knowledge of using computer to save open and use standard commands. 

ZĞƐponƐibiůitiĞƐ oĨ a �ditor

•	 Work on and edit the final output such that the Audience cannot find out 

•	 Understands the needs and requirements of the production teams. 

•	 Understands the script and require raw material to make a short decision list on the basis of value and 
contribution of respective scene and the continuity. 

•	 Edit scene to create sequence of the movie. 

•	 Insert  music, dialogues, graphics and effects

•	 Make rough and final cuts

•	 Ensure sequences logical and smooth. 

•	 Work in coordination with stakeholders for entire production, pre and post production as well. 

•	 keep up to date with new technologies and innovate for best output for industry. 
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ϭ͘ϭ͘ϲ �arĞĞr ProŐrĞƐƐion oĨ an �ditor

Fig.1.1.6: Career Progression Path of an Editor

Jr. Editor

Sr. Editor
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hE/d ϭ͘Ϯ͗ <ĞǇ tordƐ

The completion of unit will  enable:

1. Familiarise with technical terms associated animation

ϭ͘Ϯ͘ϭ 'ĞnĞraů <ĞǇ tordƐ ƵƐĞd in tŚĞ �ook
•	 �niŵatic͗ When images in a series are placed together creating a storyboard, added later with effects , sound 

and dialogs is called Animatic

•	 �oŵpoƐitinŐ͗ A combination of several images into a peocessed single frame is compositing

•	 �oŵpoƐition͗ the placement of model in accordance with background and camera

•	 �rĞatiǀĞ �riĞĨ͗ an outlining guide that provides an accurate summary of expected work like expectations, 
audiences, planned objectives, expected turnaround, budgets, parameters, investors etc

•	 <ĞǇ &raŵĞ͗ The main frame poses to begin and end frames with.

•	 DodĞůinŐ͗ The design process of creating characters that are three dimensional using software applications 
for same

•	 ZĞndĞrinŐ͗ the conversion into 2D images from 3D images by applying three dimensional effects is called 
rendering

•	 ZiŐŐinŐ͗ It facilitates movement in images as required by placing joints wherever necessary to a static image

•	 Ϯ� aniŵation͗ A flat image as, drawn on paper, in two dimensional environment but using specific software 
to create movement.

•	 ϯ� aniŵation͗ A three dimensional images that create life like experience that support the human eye as in 
like reality, like Xbox or Sony Playstation games

•	 �niŵation͗ A rapid movement of images using frames to create movement controlled by time, motion and 
speed.

•	 �nticipation͗ Pre empted or pre conceived movement as designed by the Artist

•	 �ƐpĞct Zatio͗ the width to height ratio of the picture

•	 �ackŐroƵnd PaintinŐ͗ The background to the character also known as backdrop to enhance images and 
motion

•	 �'/ ;�oŵpƵtĞr 'ĞnĞratĞd /ŵaŐĞrǇͿ͗ Computer Generated Images

•	 �ůĞanͲhp͗ Recreating image artwork on 2D images.

•	 �oŵpƵtĞr �niŵation͗ Using virtual and digital technology and applications that facilitate animation process 
on computer.

•	 &raŵĞ͗ A single series of images that is a part of animation process

•	 &raŵĞ ZatĞ͗ the speed at which frames move in series

hnit KbũĞctiǀĞƐ 
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•	 'rapŚicƐ dabůĞt͗ Creating drawings or sketches on the monitor

•	 PiǆĞů͗ Smallest component of an image like a small dot defines the resolution of the image

•	 ZaƐtĞr͗ Horizontal lines that contain pixels that is used to form an image on CRT

•	 ZotoƐcopinŐ͗ : a placement of back ground video while frames are in motion.

•	 ditůĞ �ardƐ͗ Words or sentences appearing during scenes with no audio movies

•	 T w e e n :  A process of animation that occurs between key frames.

•	 V e c tor:  A mathematical control which produces cleaner, smoother images and manually controllable effects 
and sizing using vectors rather than pixels

•	 ��>͗ A plastic sheet that is a that confluence with the background, outline, character, object or effect made of 
cellulose acetate or cellulose nitrate that can have inked or xerographical images that are coloured by hand 
or serigraph process.

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _
_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _
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EotĞƐ 
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2 .   hndĞrƐtand 
ZĞƋƵirĞŵĞntƐ and 
Půan torkŇoǁ

Unit 2.1 - Understand Requirements and Plan Workflow

D�^ ͬ E ϭϰϬϭ
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The completion of this module will enable:

1. Familiarise with production parameters and its specifications. 

<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
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hE/d Ϯ͘ϭ͗ hndĞrƐtand ZĞƋƵirĞŵĞntƐ and Půan torkŇoǁ

The completion of this unit will enable:

1. Familiarise with production concepts and their applicability to each project.

2. Plan a project.

Ϯ͘ϭ͘ϭ tŚat iƐ sidĞo �ditinŐ͍

hnit KbũĞctiǀĞƐ 

Video editing is a component in the post production which means arranging and manipulating scenes and shots 
for a different finish output. Apart from video editing other components are Sound Engineering, Special effects 
etc. 

•	 Editing is use as unprofessional term for all post production tasks. It depends on you which terminology you 
want you to use. In the below unit we use the word Editing for below. 

•	 Video Clip/Audio Clip rearrangement, addition or Removal. 

•	 Correcting Colors, Adding filters, and enhancing frames. 

•	 Correct transitioning between several clips.  

dŚĞ 'oaůƐ oĨ �ditinŐ

Many reasons to edit a video and your editing approach will completely depend on the desired outcome. Before 
you start you should clearly define the goals of your editing, which could involve below:

•	 �ůĞaninŐ ƵnnĞcĞƐƐarǇ oĨ ĨootaŐĞ͗  It’s the most common and simplest task in editing. Quality of Several 
videos can be drastically better by just removing defective or unwanted bits .

•	 �ŚooƐĞ tŚĞ bĞƐt ĨootaŐĞ͗ It is very common to shoot more footage than you actually require and select only 
the good material for the final edit. Often you will shoot many versions of a shot and select the best one 
during editing.

•	 �rĞatĞ a Ňoǁ͗ Most of the videos provide a purpose like giving information or telling a story. Editing is an 
important step in ensuring that the video flows in a manner in a manner that needs the aim.

•	 �ddinŐ ĞīĞctƐ͕ ŐrapŚicƐ͕ ŵƵƐic͕ Ğtc͗ This is the best part of the editing and video can be improved by adding 
fun. 

Fig.2.1.1: Video Editing
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•	 �ŚanŐĞ tŚĞ ƐtǇůĞ͕ pacĞ or ŵood oĨ tŚĞ ǀidĞo͗ An editor who is skilled will be  capable to make subtle mood 
prompts in a video. Techniques like visual effects and mood music can influence how the audience will respond.

•	 siĞǁ in PĞrƐpĞctiǀĞ͗ Video can be made from different perspective. Give a message or meet a purposed.

Ϯ͘ϭ͘Ϯ sidĞo PůanninŐ ZĞƋƵirĞŵĞnt and torkŇoǁ
Comprehending a life cycle of a video plan is necessary for analyzing and arranging digital workflow. A segment 
of this understanding means knowing the relationship the workflow made and decisions to be made. 

•	 Workflow Goal 

•	 The partnership concept

•	 Pre-production

•	 Production

•	 Post-production

•	 Determining what software to use

•	 Editing stages

•	 Delivery

torkŇoǁ 'oaů

The lack of not calculating decisions, this can result in an extensive amount of time spent in “fixing it in post” or 
“cleaning-up.” The work  quality will be reduce and redo could be require that may cost you. Effective planning 
and timely decision taking capacity can solve many issues as answers to common questions are already figured.  

Fig.2.1.2: A proper plan can ensure an organized production
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Fig.2.1.3: Video productions often involve a team of professionals to provide proper coverage of image and sound.

DiniŵiǌĞ riƐk͗ Video productions tend to be costlier compare to other variety of projects. Due to the big crew 
sizes and costlier gear, Along with the lengthier time to post-production times. You have got people behind the 
cameras, people in front of the lens, and even more behind the scenes. Video projects are complicated, with 
multi-stages of approval along the way. You require to control things, require to have a plan (and even another 
plan if one plan fails). Making efforts to reduce risk early in the process can minimize the chances of squandered 
money and efforts.

Proper Project managements meets the client specification and timelines accurately because of the complicated 
interconnected nature of video projects. It is significant to learn the way to balance the scope of the project, track 
your resources, and maintain the schedule you have made in advance. You must also put the scope of the project 
into writing–through this manner you can track progress and tie the billing to progress of the job.

�cŚiĞǀĞ ƋƵaůitǇ ŐoaůƐ͗ Creating high-quality video is becoming the expected standard. Improvements in 
technology and education as well as camera technology have empowered creative professionals to push beyond 
former limitations. Through proper planning, you can improve your chances of making the most of the resources 
of the project.

dŚĞ partnĞrƐŚip concĞpt

Video is called as a team game. For most of the photographers this is hardest message to accept. You have to 
make video as team work. Video is difficult for a person to be able single handedly focus their attention on 
achieving correct exposure and focus, with smooth audio and a excellent performance by the artist being shot. 
At the time of putting pieces of work together in post-production the specialist comes into picture. It may be a 
graphic designer or a sound engineer, helping hands create better work.

Video projects often have firm deadlines – Whether it’s a live event, an air date, a project launch, or a corporate 
meeting. A Schedule and strict deadlines are common for production team to follow.

You make maximum money at a job you love – Often photographers end up in other jobs like imagine one being a 
magazine publisher? Will they get advertisements or write stories themselves? Imagine if they publish a book: do 
they exaggerate  their own talent? To point out that photographers should practice their skill. Which is direction, 
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selecting locations to shoot, project lensing and applying their perspective in edits and graphics stage.  You can 
hire individuals who can better some tasks for you.

Mind is a creative bee hive that needs other team members to gather around nectar. Keeping experienced people 
around gives you focused work environment without distractions and results. 

Ϯ͘ϭ͘Ϯ͘ϭ PrĞͲprodƵction
Successful video projects hardly just happen; in fact, they often include a good deal of planning. Budgets require 
to be created, schedules made, contracts drafted and crews booked. A video shoot has several elements: shot 
design, locations, audio, directing, lighting, and video shooting, etc. All of these need planning and selections to 
be done prior to shooting.

Some photographers take a call at that moment and fail to see benefit of planning beforehand. Planning takes 
away sudden issues. Planning the camera angle, planning how the lighting will work, planning the sequence of 
shooting, allocation of crew members and how to use them etc helps in keeping production smooth.

It is recommended to plan beforehand to direct crew when one sequence is done to other. perfect pre-production 
saves you money and time — two factors that are very important. At the beginning of the shoot, one must have 
planned the complete shoot in your head, on notes, in discussion with team members, and in as several ways as 
possible in advance.

Fig.2.1.4: A detailed schedule is often part of the planning process.
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KƵtůininŐ ƐcopĞ

A good outline of project scope is a common reference for both producer and client. The scope details all the 
deliverables of production with measurable parameters. This is called a scoping document that captures the key 
project details and clearly defines deliverables for both team and client. It can be as extensive as you want.

The schedule and the budget determines the scope of project. Scoping a project usually takes about two to 
sixteen hours to finish (depending on its complicacy). When you are completed, you will end up with a document 
that is typically of two to ten pages in length. This brief document is extremely important because it documents 
minute details of the project and is a guide for team. Some get clients are involved to sign off to ensure all are 
understanding same deliverables.

ProũĞct ƐcopinŐ docƵŵĞnt ƐkĞůĞton

Pointers that should be covered:

•	 Project name 

•	 Executive summary 

•	 Background 

•	 Project scope (high level)

Fig.2.1.5: A scoping document is an essential piece of the project management plan.
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•	 Project objectives

•	 Deliverables

•	 Organizations

•	 Interfaces required

•	 Assumptions

•	 Constraints

•	 Evaluation criteria

•	 Risks

•	 Rewards

•	 Budgets

•	 Schedules (due dates)

•	 Project team readiness

•	 Key roles:

 » Executive sponsor

 » Project manager

 » Business experts

 » Technical experts

•	 Signature lines – Sign off "charter"

Fig.2.1.6: A successful production typically takes much more equipment than just a single camera.
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hndĞrƐtandinŐ rĞƋƵirĞŵĞntƐ oĨ ĞƋƵipŵĞnt 

In the beginning of the project you’ll need to understand what equipment is required. Camera is around which 
action revolves. The staging and planning is for camera recording. You will select from a variety of gear to ready 
the camera to record what is required. You’ll also decide the lenses that will be needed to capture the vision of the 
director. Lighting planning and equipment arrangement should be done for shots as required. The responsibility 
of camera, lenses, and accessories is not only to shoot required shots but to enhance creativity of look and feel.

Not just production but project’s post-production is also crucial. You may be required to record details about the 
project like continuity or resources. Is there any additional after work like special effects? Is the desired output 
format decided? Is your camera equipped to meet specifics of client?

ProũĞct dĞǀĞůopŵĞnt

While working on a project you will create many items. Below are some standard work pieces of industry. Even 
then script may not be part of all projects the remaining are important.

•	 ^cript͗ A well made script enhances good ideas into better perspectives and visuals. There are dedicated 
scriptwriting software tools that can be used (like Final Draft and Final Draft AV). Microsoft Word or Apple 
Pages documents can also be formatted to use video two-column option.

•	 �ƵdŐĞt͗ Prior discussion you should be aware of your financial restrictions. Creative minds can get carried 
away by non realistic ideas or impractical plans. To know the costs and scope of work involved always create a 

line item budget. It supports a lot of client in depth expectations about pricing. You can share this with other 
team members to give timelines and budget allocation. You can remove the pricing column when sharing 
with others.

•	 ^cŚĞdƵůĞ͗ You should know your project milestones and plan efficiently to work accordingly. Keeping a 
calendar handy with reminders to track milestones can help deliver the project as expected. 

•	 drĞatŵĞnt͗ An explanatory description of the project is called the treatment. It is also known as a pitch or 
an elevator. It is a single document that defines the structure and centre of the project. This influences the 
approaches and perspectives of team and clients by clear communication.

Fig.2.1.7: An excerpt from a detailed line-item budget

Ϯ͘ϭ͘Ϯ͘Ϯ ProdƵction
The production stage is where all your efforts collectively meet. Every project has its own requirement of gear 
– ranging from as detailed as lighting to types of lenses to be used. More than one camera can be required for 
accurate coverage and smoother editing of any event. Larger production houses there are specific roles to each 
whereas smaller productions can perform various roles
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�boƵt tŚĞ ProdƵcĞr

The Producer is responsible for the project budget and intricate details like planning the scope, designing the 
schedule and budget allocation. He should not get distracted by focusing on the creative aspects but on the 
practical criteria to make the project sustainable.

�boƵt tŚĞ �irĞctor

He is incharge of the creative and artistic view of the project. He must allocate responsibilities to team on set 
to successfully execute the creative vision. He himself does not do all tasks but works as the Leader to get work 
done as per his vision.

dŚĞ �irĞctor oĨ PŚotoŐrapŚǇ ;�PͿ

The Director of Photography(DP) and the Director work closely to get the project alive artistically. He also works 
with the Camera Operator. The technical parameters like the camera angle, lens are often given by the Director, 
but sometimes the Director of Photography can also prescribe it. The Camera Operator, Director and DOP can 
also be same on smaller projects.

�rĞǁinŐ ĞƐƐĞntiaůƐ

Increasing crew size leads to capturing more footage and detail. A single person can do limited work but two 
or three people can increase the delivery. Due to the complicated nature of video, that needs those behind the 
camera to focus on lighting, audio, composition, and continuity.

The following crew positions must be strongly considered for each of the shoot, depending on logistics and 
budgets:

Fig.2.1.8: A healthy balance of teamwork and camaraderie must be maintained on set.
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•	 �Ƶdio �nŐinĞĞr͗ He ensures audio is captured in correct volumes and it a very crucial position and requires 
only best professionals for it.

•	 'aīĞr͗ He takes care of light designing on the set. He arranges lights on the shoot accordingly. Sometimes 
the photographer can also do this job.

•	 'rip͗ The technician who helps in implement lighting on set is called grip. They also help create and manage 
smooth camera movement along with the photographer. They also handle tripod and dollies.

•	 �aŵĞra KpĞrator͗  On larger budget productions, it is common to have a Camera Operator working under 
the direction of the DP. In a multi-camera shoot, there will typically be a Camera Operator for each camera.

•	 �aŵĞra �ƐƐiƐtant͗ A camera assistant is responsible for setting up cameras and lenses. If you are using 
multiple cameras on a project, it is best to hire a skilled person to fill this role. The camera assistant can also 
help with complex camera movements and manual focusing during a shoot.

•	 �ata dĞcŚnician͗ Video files are big, so you’ll quickly fill up your memory cards. The data technician is 
responsible for archiving memory cards to multiple drives and returning cards to the photographer for 
reformatting and reuse. If you don’t have a data tech, plan on having lots of memory cards and staying up 
late to clear them all off.

Fig.2.1.9: Multiple crew members are often needed to cover an event properly.
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Ϯ͘ϭ͘Ϯ͘ϯ PoƐtͲprodƵction
Post production is where all the elements part of the video are join to gather. All the production material is 
entered into the computer so that you can start working on them for the final output. Here the audio and video 
footage are combined, and the story is refined so that only the best footage stays. When completed, you will 
be capable to see the finished project that you have visualized. Post production is the lengthy process but if 
structured it becomes easier. 

PoƐtͲprodƵction aiŵƐ͗ 

Post production initiates with media management. A lot of data needs to be arranged and back up needs to 
be created. You have to get into the habit creating long term backups by transferring your data into the editing 
drives. Also after maintaining your archives you have to decide the final shots from the extensive footage. This 
process called making Selects and it can be occur during different process of post-production. The aim is to 
organizing your data for you to get a structure for editing. 

Editing is the core of the post production. It is where entire projects take live like bits and pieces come to gather 
for a continuous story. You would have shot a lot of footage for the final output but editing gives the shape to the 
final output because you choose the best part to create a sequence. 

As the story progresses other tasks also have to initiate. Like sound mixing, colour correction, improving the visual 
appearance by balancing all audio-visual elements. Other elements like graphics, special effects and transitions 
also come into post production.

Fig.2.1.10: The editing stage is often collaborative, just like production
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�ĞtĞrŵininŐ ǁŚat ƐoŌǁarĞ to ƵƐĞ

Your technical and business requirements should be met by the software you choose to use. However, it is difficult 
to point which software will suit you the best, as it will be your personal experience as well. There cannot be one 
software right for all and below factors can help you determine it:

•	 �oƐt͗ Tools like iMovie and Windows Movie Maker are included with Apple and Microsoft’s operating systems. 
At a higher level, Apple Final Cut Pro X for Mac and Adobe Premiere Elements or Sony Vegas Movie Studio 
are available. They are better at controls and features and hence are complex to learn where fluency comes 
over time. Common options used are Avid Media Composer or Adobe Creative Suite Production Premium.

•	 �aƐĞ oĨ ƵƐĞ͗ It depends on the user and his learning curve. It is significant to realize though that video editing 
is a complicated task. Be prepared to pick up training DVD’s’ books, and even undertake training to learn 
editing skills. If you will buy expensive gear and equipment then even the cost to understand it will increase.

•	 �ditinŐ ĨorŵatƐ͗ Non Linear editing tools determine the camera types to be used as many camera manufacturers 
have tie ups with them. Its recommended that you do ample research on manufacturer websites before 
investing in any gear. You must have prior knowledge about the equipment and supported formats.

•	 DƵůtiͲcaŵĞra ĞditinŐ abiůitiĞƐ͗ Todays demand is a multi faceted camera that can edit as well as synchronize 
video angles this is the new gen cost effective and time saving method. Since angles are already synchronized 
the final edit becomes easier. This is available in most of the pro level gears

•	 �ƵƐtoŵĞr ƐƵpport͗ Do your prior understanding of the after purchase service And tools for understanding 
provided by the company support. Is there an explanatory DVD? Can you undertake certification to train for 
the same.

�ditinŐ ƐtaŐĞƐ

As opposed to photography. In editing colour correction and grading is done after the assembly and not as you 
select shots. It is a common method to get the assemble ready for client and team feedback and keep amending 
with the flow and period till the finished output. Get to know the stages below for video editing, like mentioned 
earlier depending on the cost involved they may vary. A feature film requires more edit than a news story.

•	 �ƐƐĞŵbůǇ �dit͗ Assemble edit means arranging the sequence by putting clips together in the correct order. It 
is also called the radio edit as its similar to the radio storytelling concept. This enables to understand what is 
the complete length of the project and can be gathered stake holders reaction against. 

•	 ZoƵŐŚ �Ƶt͗ This stage gradually adds elements like dummy sound tracks or additional footage but it is not as 
polished as there will be no colour correction or special effects done yet. The inside truth is that many such 
rough cuts are created till the producer, director and editor have complete confidence in taking feedback 
from stakeholders. While watching a rough cut you must identify the missing links that may enhance the 
finished product. 

•	 F in e  C u t:  It is an almost complete video. This stage gives definite time length and sequence of shots. This 
is the closest to the final, only polishing has to be done on it. The aim to get final feedback from client and 
incorporate those, till other teams start their final task of sound and effects. Last graphics and elements are 
put in and a final reaction of client is taken for last changes if any. 

•	 &inaů �Ƶt͗ The Final Cut is called an Approval Copy as it incorporates all the feedback, requests and changes 
as per client. This is mere stage where the changes have to be only reviewed by client. Changes now cannot 
be included. Professional Contracts state that Final Cut will not take in any changes as they will not be in the 
scope however included.
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�ĞůiǀĞrǇ

It is the last stage called as .completion of project life cycle where project is published and archived.

PƵbůiƐŚ

Work must be showcased on mediums to gather creative feedback for betterment. Mediums like web, galleries 
or portfolios are used to display work done. Publishing determines growth both personally and professionally.

In a fast paced media world, everything is connected with web. As ingle viral news of tele vision is already on 
social media and available on the go. So publishing work on various media handles is the distribution online. It 
makes it easier for clients to access and share. Today digitalized files are the game.

Fig.2.1.11: Final Cut Pro X offers the ability to publish direct to video sharing sites like Vimeo and YouTube
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�rcŚiǀĞ

A master file needs to be created for your project. A master file is the self contained file that you can make 
additional changes or outputs to without downloading the entire project over and over. You can consider 
intimating the media manager to help you gather all assets. Use efficient backup media systems as LTO tape or 
Blu-ray disc.  

Fig.2.1.12: Creating a self-contained master file using the Apple ProRes codec from Final Cut Pro X.
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Ϯ͘ϭ͘ϯ ProũĞct PůanninŐ
The project plan is a broad concept that not just involves creating a Gantt Chart but other objectives that determine 
the project scope, schedule, necessary requirements, cost estimation of project and analysis of quality. Planning 
also involves risk management.

It helps the project manager to breakdown tasks required by inputing requirements into the Work Breakdown 
structure (WBS), task lists, Gantt charts, risk register etc.

Project is initiated only once the charter is approved as planning it is based on the charter document and project 
requirement document.

tŚǇ iƐ proũĞct půanninŐ rĞƋƵirĞd͍

Planning helps in getting a structure and also estimating risks in the project. You foresee the certain factors and 
are prepared for uncertainty. In a carefully planned project, the expected outcomes and probable risks are made 
provisions for already.

Although we cannot be fully prepared for unexpected outcomes even though we mention all situations and risks, 
but being ready or organized helps tackle unexpected better. So we can save on time, money and resources.

Fig.2.1.13: Project Planning
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�ůĞŵĞntƐ oĨ proũĞct půan 

Fig.2.1.14: Element of Project Planning
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ϯ͘  DanaŐĞ �ƋƵipŵĞnt 
and DatĞriaů

Unit 3.1 - Manage Equipment and Material

D�^ ͬ E ϭϰϬϮ
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The completion of this module will enable:

1. Manage equipment and material to be used in your project.

2. Familiarise with different softwares/tools of video editing

<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
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hE/d ϯ͘ϭ͗ DanaŐĞ �ƋƵipŵĞnt and DatĞriaů

The completion of this unit will enable:

1. Manage equipment and material to be used in your project.

2. Familiarise with different softwares/tools of video editing

ϯ͘ϭ͘ϭ HardǁarĞ �ƋƵipŵĞnt ƵƐĞd Ĩor sidĞo �ditinŐ
H� �s caŵĞra͗ Camera is used to shoot video clips on spots. 
Camera should be digital and high definition so that the clip 
could be shot more clear.

hnit KbũĞctiǀĞƐ  

A high configuration computer with:

•	 i-7 CPU

•	 1 TB HDD

•	 4 GB RAM

•	 DVD Writer

•	 Additional graphic card 4 GB

•	 Multimedia Keyboard

•	 Good Quality wireless Mouse etc. 

^toraŐĞ �ĞǀicĞƐ͗ A video editor needs storage devices with high volume to save and store the high definition 
video clips. Storage device/media can be:

•	 �oŵpact �iƐkͬ�iŐitaů sirtƵaů �iƐk͗ DVD/CD is a compact, easy to 
carry digitalized storage system that is made of molded polymer 
and enables storage of recordings, audio, video, text and data 
information. Tape cartridges and CD/DVDs generally replaced 
the phonograph record for playing back music. At home, CD/
DVDs have tended to replace the tape cartridge although the 
latter is still widely used in cars and portable playback devices. 

Fig.3.1.1: HD Camera

Fig.3.1.2: Desktop Computer

Fig.3.1.3: CD/DVD
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•	 �ǆtĞrnaů H��͗ An external hard drive is connected to the 
computer via the USB or FireWire and is a storage device 
for larger files, as has higher storage capacity as a common 
medium for backups.

•	  &ůaƐŚ �riǀĞ͗ A flash drive also known as USB or pendrive that 
is portable, compact and used for lightweight file transfers 
and uses flash memory. It is an alternate to floppy disk, CDs or 
zip drivers. When inserted in the USB socket of the computer 
it recognizes with a Letter, eg: Portable Drive inserted G:/E: 
drive. 

•	 HĞadpŚonĞ͗ Headphone are used to hear the sound of video 
clips. The role of headphone is very favourable while synching 
video and audio together. 

•	 H� tĞbcaŵ͗ Not much used in editing but can be helpful if 
some urgent clip is to be shot.

Fig.3.1.4: HDD

Fig.3.1.5: Flash Drive

Fig.3.1.6: Headphone

Fig.3.1.7: Webcam
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ϯ͘ϭ͘Ϯ sidĞo �ditinŐ dooůƐ
tindoǁƐ DoǀiĞ DakĞr

Windows Movie Maker is a video editing tool that enables creating movies/clips by simple drag and drop and can 
add effects, transitions, titles, audio tracks, narration etc on the video. It is used for home created movies. Effects 
can be changed, added or altered using the XML code.

sirtƵaů�Ƶb

VirtualDub provides pro features like compression, video splitting apart from effects, transitions and audio. It also 
has processing capacity for large files and open to external filters. This software is for Windows and free.

Fig.3.1.8: Windows Movie Maker
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taǆ

Wax is suitable for home and professional use both. It is high performance software but the editing functions are 
limited in manner. It does not provide advanced features like Mosaic, JumpCut, Flashhold or transitional effects, 
sound effects etc like Wondershare Filmora does. You can choose to switch as your preference depending on 
the level you are working. Wax however is flexible and can be plugged in to other video editors or used as stand 
alone.

Fig.3.1.9: VirtualDub

Fig.3.1.10: Wax
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�ǀidĞŵƵǆ

Avidemux  is a basic editing tool that  cuts, filters and encodes tasks. It is available free and compatible with 
different file formats like DVD, MPEG, MP4 etc 

&&DpĞŐ

FFmpeg can record, edit and stream videos from audio and video codec libraries as it is a collection of softwares 
that work in libavcodec and libavformat. It is a paid software.

Fig.3.1.11: Avidemux

Fig.3.1.12: FFMpeg



36

Participant Handbook

�ůĞndĞr

Blender is one of the advanced video editors for Windows and MAC that enables 3D creations having tools 
like modeling, animation, transitions etc that support most major operating systems  under the General Public 
License. It is a free open software.

Fig.3.1.13(a): Blender

Fig.3.1.13(b): Blender
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�^ϰ sidĞo �ditor

ZS4 Video Editor is an editor software that is free and enables combining photos, videos and audio editing and 
compositing. It is perfect for professionals and available free. 

�inĞĨǆ :aŚƐŚaka

Jahshaka is the first Open Source Realtime Editing and Effects System  and is the best video editing software that 
supports Linux, Windows and OS X. Being Open it gives excellent performance due to OpenGL and OpenML.

Fig.3.1.14: ZS4 Video Editor

Fig.3.1.15: Cinefx Jahshaka
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>iŐŚtǁorkƐ

Lightworks is an excellent editing software that provides various techniques and used in many videos that are 
featured. It has a capacity to edit 256 videos and audio and hence is technical difficult to use.

Doǀica

Movica provides the benefit of  keyboard shortcuts making it easier. It is a well known software , available free 
and supports WMV, FLV and MPG files.

Fig.3.1.16: Lightworks

Fig.3.1.17: Movica
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�dobĞ �ŌĞr �īĞct

Apart from other things Adobe After Effects provides digital tracking, graphics, animation, keying and compositing. 
Also facilitates non linear editor, audio editor and media transcoder. It is used in film and television making widely.

�dobĞ PrĞŵiĞr 

Adobe Premiere is a software application that is timeline-based  of the Adobe Creative Cloud. It enables s video 
editing, graphic design, and web development programs. The following module will cover use of this software in 
editing`

Fig.3.1.18: Adobe After Effect

Fig.3.1.19: Adobe Premiere
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ϯ͘ϭ͘ϯ DanaŐĞ �ƋƵipŵĞnt and DatĞriaů
Gather raw footage/material (e.g. dialogue, raw camera footage, graphics, sound effects, special effects) and 
select pertinent material that can be used for post-production. You should ensure that work-products are ready 
as per the required technical specifications. Gather raw footage/material (e.g. dialogue, raw camera footage, 
graphics, sound effects, special effects) and select pertinent material that can be used for post-production. Ensure 
that software and equipment that you will have to work on are ready for use. Use correct file formats to create 
backups. Make sure final work-products are prepared in suitable file formats (e.g. avi, mp4, wmv, mov and mpg) 
that are compatible with mediums like DVD, MPEG etc and meet the distribution or display criteria. Make sure 
your logs are emptied to ready equipment and software for further use.

You must have adequate practice with particular equipment and software e.g. Adobe Premiere, FinalCutPro, 
Avid, After-Effects and sound cleaning software etc. Make sure that the material format, quality and resolution 
can be ingested in the system and matches the desired output identifying concerns prior to ingestion. The storage 
media you use should be relevant to the type of production. You should also ensure that file-naming conventions 
appropriate to the production.



ϰ͘ �dit tŚĞ ProdƵction
Unit 4.1 - Edit the Production

Unit 4.2 - Audio and Video Formats

Unit 4.3 - Project Testing

D�^ ͬ E ϭϰϬϯ
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The completion of this module will enable:

1. Work on Adobe Premiere CS 6.5

2. Capture and edit videos

3. Familiarise with the different types of Audio and Video formats

4. Use the different formats relevantly

5. Familiarise with containers, codec and bit rate

6. Paraphrase how to test a deliverable output.

<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
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hE/d ϰ͘ϭ͗ �dit tŚĞ ProdƵction

The completion of this unit will enable:

1. Work on Adobe Premiere CS 6.5

2. Capture and edit videos

ϰ͘ϭ͘ϭ �dobĞ PrĞŵiĞrĞ ϲ͘ϱ

hnit KbũĞctiǀĞƐ  

Adobe Premiere Pro is Adobe Creative Cloud based software that is commonly used in film and video features. 
It provides various techniques apart from video editing like graphics design, web development and is timeline 
based.

Adobe Premiere is compatible with high resolution video editing for up to 10,240 × 8,192 resolution, also supports 
up to 32-bits per channel color, in formats of RGB and YUV. Premeir also provides sample-level editing for audio. 
It has a VST audio plug-in support, and sound mixing of 5.1 surround. Its plug-in architecture enables it to export 
and import formats beyond those supported by Direct show or QuickTime, supporting a vast variety of audio and 
video file formats and codecs on both windows and MacOS. For 3D editing it can be used alongwith Cineform's 
Neo line of plug-ins, and can view 3D material using 2D monitors, when making individual right and left eye 
adjustments.

Fig.4.1.1: Adobe Premiere
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/ntĞrĨacĞ KǀĞrǀiĞǁ HiŐŚůiŐŚtinŐ <ĞǇ dooůƐ

•	 ProũĞct &iůĞƐ͗ All your files are imported here. All the movie sequences, photoshop files, sound files etc. can 
be accessed from the bottom panel where you can organize the files you are working on. 

•	 �īĞct �ontroůƐ͗ You can control effects with this panel by switching from one panel to another, like the active 
one to sound controls. You can toggle, scale and rotate using the Motion control that is available by default. 
You can re adjust the speech of your clip with opacity controls and time re mapping. 

•	 diŵĞůinĞ siĞǁ͗ It states the current point in your timeline.

•	 �īĞctƐ PanĞů͗ Effects like dissolves and transitions can be found on this tab. 

•	 <ĞǇĨraŵĞ �ƵƩon͗ You can add and remove keyframes with this tab.

•	 ^caůĞ ^ůidĞr͗ You can scale your timeline by zooming  in and out.

•	 �ƵtͬZaǌor dooů͗ This facilitates cutting your clips in various parts for editing.

•	 DoǀĞͬ^ĞůĞct dooů͗ Change the default cursor by using this tool

ϰ͘ϭ͘Ϯ ^tartinŐ a EĞǁ ProũĞct
When you start a new project you have to enter your settings for it. Click on Adobe Premier icon and a window 
will ask you for project specifications for video, multimedia etc.

Select DV-NTSC Real-time Preview Standard 48KHz mode to enable you to work with full quality video clips. It 
also lets you see any fades, filters and effects prior to rendering. You can change your specifications as required.
Click OK once selections are entered. Click on “Save As” in the File Tab Menu  and name the file.

Fig.4.1.2: Starting a New Project
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 A preset setting can be made for you that defaults later use. Video Settings and Audio Settings are of utmost 
importance.

Go to Project>Project Settings>Video to see the screen below

•	 �oŵprĞƐƐor͗ select a codec you require from the list. Use the DV - NTSC codec to export to tape or DVD

•	 �ĞptŚ͗ selects the number of colors. Should be set to millions in most cases.

•	 &raŵĞ ƐiǌĞ͗ select the playback screen size, 60x45-

Common sizes:   

2000x2000 ommon sizes:

 » 160x120 (www)

 » 240x180 (cd-rom)

 » 320x240 (cd-rom/tv preview)

 » 640x480 (television)

 » 720x480 (raw video)

•	 &raŵĞ ratĞ͗ standard playback rate is  1-30 frames per second (fps) but use rate more than 15 fps for a  
smoother playback. However keep rate at 29.97 if saving to CD or Web 

•	 YƵaůitǇ͗ while selecting the compression amount keeping it on a higher side will increase the file size..

•	 ZĞcoŵprĞƐƐ͗ For exporting to tape.

Fig.4.1.3: Project Settings
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�Ƶdio ^ĞƫnŐƐ

Use the pull down menu by Going  to Video in the Project Settings  drag down to select Audio, You can also select 
Project>Project Settings>Audio.

•	 ZatĞ͗ Increase file size even though higher rates sound better

•	 &orŵat͗ 16-bit sounds better than 8, but increases file size. 

•	 �oŵprĞƐƐor͗ You can compress the audio using any of the codecs. 

•	 Note: Above are examples to help understand editing process. You can use specific settings for final movie. A 
slower processor supports lower resolution else slows down. 

•	 P roj e c t W in dow

It shows the images, sound, and video files 
you that are called clips being used in the 
current movie. When you Double-click a clip 
it shows it in the clip edit window. You can go 
to File>Import>File to import new clips and 
graphics. Folders containing clips are called Bins 
and can be many to help you classify clips. Go 
to File>New>Bin to start a new bin. You can also 
add, delete and rename bins as when you import 
new files or graphics they automatically go into 
the default bin.  

Fig.4.1.4: Project Settings (Audio)

Fig.4.1.5: Project Window
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diŵĞůinĞ tindoǁ

This shows the audio or video tracks on the timeline in transition. The below Video 1 track is split into two tracks, 
called A and B. The transition track sits between them (this is A/B Editing Mode, probably best for beginners).

On the upper right corner you can add, remove,  name audio and video tracks in the Track Options menu. 

Donitor tindoǁ

All the transitions and modifications are shown in preview in the right box of the selected clip. You can also trim 
clips with this function.

Fig.4.1.6: Timeline Window

Fig.4.1.7: Monitor Window
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dranƐition tindoǁ

You can see all the transition effects in the project window in this just like you see video clips. You can just drag 
the transition track between Video A1 and Video B1 track or you can place it between two clips.

You can use plug ins to add transitions. By dragging the blue indicator called the playhead you can view the 
transition through that video portion. Also, Preview can be selected in Timeline menu.

sidĞo �īĞctƐ tindoǁ

It shows all the video effects that can be used to the current clips. You can drag the effect you require into the clip 
to use the entire effect or set points by using keyframes when the effect can effect in the clip. Ensure rendering 
the effect after applying it by going to Timeline, Preview.

�Ƶdio �īĞctƐ tindoǁ

You can see the variety of audio effects that can be used. Audio effects do not require rendering and can be 
applied as whole or by using keyframes depending on the required control.

Fig.4.1.8(a): Audio Effects Window Fig.4.1.8(b): Audio Effects Window

Fig.4.1.8(c): Audio Effects Window
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KtŚĞr ǁindoǁƐ

�īĞct �ontroůƐ͗ You can control effects on each clip in the timeline.

/nĨo͗ Information about currently selected clip.

EaǀiŐator͗ There are two outlines that show the bird eye view of the 
project helping you to go to different parts of project easily. The green 
shows the current displayed timeline and the red vertical shows the 
resting of playhead. Use the green outline box to work fast through 
your project.

HiƐtorǇ͗ Records all the steps you have taken and helps you make undo 
changes made previously or make a new edit, but with this you will 
lose the steps done later on the clip 

�oŵŵandƐ͗ It has user-definable shortcuts.

Fig.4.1.9: Effect Controls

Fig.4.1.10: Info

Fig.4.1.11: Navigator

Fig.4.1.12: History

Fig.4.1.13: Commands
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ϰ͘ϭ͘ϯ /ŵportinŐ �ůipƐ

ϰ͘ϭ͘ϰ �aptƵrinŐ sidĞo

For importing clips go to File->Import. You can select from 3 options: 

File for a single one, Folder for a group of files and a Project to use another Premiere project. 

 Movie files are in the format of AVI, MOV, DML*, AVC*, PVD*

 Still image files will be found in JPEG, GIF, PSD, TIFF, PICT, AI, TGA, BMP*, PCX* formats

 and you can find Sound files in AVI, MOV, AIFF, WAV* formats

 Animation files that are on windows version only will be in TGA, FLM, AI, PSD, GIF, PICT, FLC*, FLI*, BMP formats. 
On selection of the folder it gets imported in the Bin.

•	 The VCR captures into the VHS tape. 

•	 To capture from other analog format connect it to the front 
A/V inputs of the VCR and select Line 2 as the input.  Reset 
to Line 3 when done.

•	 You can connect a FireWire cable to the media converter box 
to capture directly from a DV camera.

 

Select File>Capture>Movie Capture in the pull down menu.

Fig.4.1.14: Importing Clips

Fig.4.1.15: VCR Ports

Fig.4.1.16: Connecting Camera

Fig.4.1.17: Capturing Movie
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You can use the tape controls to capture video or Capture Window controls if you have a LANC connection. Follow 
the basics of Record when starting and Stop when finished. The video saves itself in the project window when 
done.

Incase you fail to see video you are recording, your screen will look like the below:

Go to Enable Device Control button after checking your connected cable and see the below.

Fig.4.1.18: Capturing Movie Window

Fig.4.1.19: Device Control
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That will bring up this window:

Select the DV Device Control 2.0 and click 
the Options tab. In the window that pops up 
select your Camera/VCR model.

Click on the Check Status button to ensure connectivity It will show offline is the device is not connected and 
online if check was fine. Press OK to finish.

Fig.4.1.20: Preferences

Fig.4.1.21: DV Device Control Options

Fig.4.1.22: Placing Clips in the Timeline Window
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PůacinŐ cůipƐ in tŚĞ diŵĞůinĞ ǁindoǁ͗

Begin assembling the clips into a movie by dragging them into the respective tracks in the timeline. Transitions 
will be placed between Video 1A and Video 1B tracks for videos. Clips below will be overlapped by Video 2 track. 
Upto 99 video or audio tracks can be made over Video 2 track. Premiere makes layering easier by automatically 
arranging hierarchy from higher to lower. The higher tracks cover video clips in the lower ones eg, if my video is 
in Video 3, then automatically it will cover any video I have in 2 and 1B thus making it easier for smaller clips to 
layer larger ones.

Clips that have audio and video are called linked clips. The video can be linked only with the corresponding audio, 
it can also be broken to synchronize with the video. Eg: a person speaking

By using the Zoom tool in Time Unit Selector on the Timeline, you can 
focus in and out to properly adjust time and length of the clips.

�ƵƐtoŵiǌinŐ ǇoƵr diŵĞůinĞ͗

Select Window>Timeline Window Options.

You can select the size and the period type of clips in the frame. Like the beginning or end, or just the name This 
is helpful on slow processors where drawing each frame takes a lot of time. Sizes can be from small to large to 
select view.

Fig.4.1.23: Unit Selector

Fig.4.1.24: Timeline Windows Option
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ϰ͘ϭ͘ϱ do DodiĨǇ �ůipƐ
Note: The same clip can be used to use its various parts as required or to apply effects as necessary and this will 
not affect the original clip. These clips are an instance of the original and don’t change on modifying. 

•	 DoǀinŐ͗ Select the arrow tool to drag the clip to a new location.

•	 ^půiƫnŐ͗ Use the Razor   tool to split a single click and multiple razor tool to split the entire timeline. on. 
The audio will also split when the razor tool is used. 

•	 �ĞůĞtinŐ͗ When you select Delete, there comes a gap in the timeline when the clip gets deleted. Use Ripple 
Delete to move all the subsequent clips and close the gap. One more way is to use the Lift or Extract button 
to select a part of the movie in the timeline. Lift leaves a gap as well and Extract fills the gap with subsequent 
clips. Ensure to use the Target Pull down, select target track to see the clip you are removing. 

driŵŵinŐ͗ Trimming helps in changing the duration of the clip by cutting or trimming the beginning or end. 

You can trim in many ways:

1. The fastest way is to place the cursor at the beginning or end and see the Ripple Edit tool to drag the length 
you want to trim. You can only shorten using this tool.

2. A precise way to trim is using the Edit Window in the timeline, use the Play button to view and select the spot 
you want to trim or end.

3. For setting a starting point Press In  to set a starting point. Press Out  to set an ending point.To confirm 
Press . The clip on the timeline will be trimmed accordingly.

Fig.4.1.25: Monitor
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A u dio

You can control audio related factors here, click on the speaker to put sound on or off, besides this icon you can 
click to lock or unlock the track. The triangle icon shows track controls. These four controls can turn sound wave 
on or off, the second controls audio effects. There is a red button that can be pulled along the band to increase or 
decrease volume and the blue button can pan to left and right. Various handles can be used for complex sounds.

PrĞǀiĞǁinŐ

This version of Premiere lets you see the effects you have applied in real time by placing your playhead at the 
beginning of your clip or at the position you want to check the effect. You can press Enter key on keyboard or 
Preview on timeline menu. Effects have to  be formally rendered prior to saving the movie.

Fig.4.1.26: Movie Clip on Monitor

Fig.4.1.27: Audio Selector
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ϰ͘ϭ͘ϲ dooůbar
On the top left of the timeline window you will see many tools available for editing. Some have a small triangle at 
bottom stating more options in the tab where you can see the hidden tools. Some tools are shown in the pop up 
window when you click and hold a tool down. The page after gives description of each tool.

Fig.4.1.28: Adobe Premiere Toolbar
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ϰ͘ϭ͘ϳ dranƐitionƐ

ϰ͘ϭ͘ϴ sirtƵaů �ůipƐ

ϰ͘ϭ͘ϵ sidĞo and �Ƶdio �īĞctƐ

Go to Windows> Show Transitions

Transitions always happen between two track A and B. To place the transition between them drag it from the 
transition window to timeline transition track where it will go blue when accepting the transition in by filling the 
gap between A and B. Keep a good hole in A and B to overlap the transition track fully for both laps. In case using 
the Single Track Editing option when you drag a transition the colours will invert accepting the transition their in 
editing keep till invert.

You can change transition settings by double 
clicking the transition thumbnail to open a 
dialogue box where you can manipulate sliders 
to set the percentage of transition which are 
below A and B, for setting which direction the 
transition will work from B to A or otherwise 
there is a arrow beneath the thumbnail to do 
so. To manipulate the forward or backward 
direction use the thumbnail at the top right 
while the white arrows will control overall 
direction. There are some transitions that have 
a toggle to smoothen. Every transition has a 
different option

Virtual clip is the original clip on the timeline, that is referral clip hence all changes on original will reflect on the 
virtual also, including deletion. Premiere lets you choose a cross-section of the time line and make it a virtual 
clip. By using the Block Select Tool that you will find to the right of the Arrow tool to select and drag an area 
to another location. Although the new virtual clip contains several tracks it will require only one. You can use 
complex transitions to layer several tracks.

Go to Window>Show Video Effects to open the Video window alternatively you can go to Video tab in the Audio 
effects window, using a simple drag and drop apply the effect on the timeline. To further adjust your selection 
use the Effects Control window. To see how the transition works use the Preview tab from Timeline or move the 
playhead.

Fig.4.1.29: Page Peel Setting
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Audio effects can be applied just like Video effects by the Transitions 
tab or by Show Audio Effects under the Window menu. Use the same 
method as drag and drop and control adjustment in the Effects Control 
window. Audio effects do not require Preview to be heard 

A chosen effect works on the entire clip however use Keyframes to select 
the end and beginning of the transition. You can add more keyframes 
by the playhead by adding a new point and clicking on the keyframe 
navigator.

Popup menu will appear at the beginning of the keyframe track when 
you add more than one effect to let you toggle between applied effects. 
You can also combine effects, but  that will increase rendering time for 
each effect added. To Control each effect, Go to Window>Show Effect 
and control by the Effect Control window.

�ontroůƐ

All the parameters for adjustment of effects can be seen here.

Each keyframe can be set to parameters as per requirement by 
clicking on the applied effect on the keyframe .You can decide the 
changing time and Premiere calculates the smooth progress within 
each change.

Fig.4.1.30: Video Properties

Fig.4.1.31: Keyframe Windows

Fig.4.1.32: Effect Control
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Dotion

Go to video options>Motions after selecting a clip to Rotate, 
Resize, Move or Distort on the timeline. You can also use 
the Effects Control window to open the motion dialogue 
box. There is a thumbnail that is attached to the clip path 
where you can adjust or create a new point that has its own 
rotating zooming or distorting edits. 

You can increase the speed or slow down the speed. Use the Motion Pull Down button for every point for the 
path. Additional treatments like filling a background color by the fill color tab and smoothening the motion by 
Smooth Motion tab. There are many existing settings in premier that can be used which are available in the 
Premier folder in your Hard drive. You can select the required motion by going on the load button in the motion 
dialogue box within the folder. 

Fig.4.1.33: Effect Control (Motion Control)

Fig.4.1.34: Motion Settings
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^ƵpĞriŵpoƐinŐ

Superimposing helps you edit the visibility of each clip by placing clips on top of each other. Select a clip on 
the video track apart from video 1A or 1B then go to Choose Clip>VideoOptions>Transparency… to open the 
Transparency Settings window.

You can achieve various effects by selecting different types of keys in Premier. Superimposing also called as 
keying. Commonly the color window is use where on clicking the window you can choose the color you wish to 
work with. You can also make use of the many sliders in it. 

Adjust the area of the clip you want to use the key on by manipulating the white squares in the corner of small 
preview window that appears. See the effect of the applied key in the Page Peel Icon. 

ϰ͘ϭ͘ϭϬ ^oŵĞ <ĞǇinŐ dǇpĞƐ
�Śroŵa͗ Television uses a key called Chroma which lets you choose color transparency or a color eg. Weather 
maps done by Meteorologists. Successful keys are uniform in color and keys actually work by deleting certain 
colors eg. To remove the backgrounds behind the person have them against the single color wall.  O Remove the 
shadows of the person by using many lights to highlight a person to eliminate any key color on their clothing or 
body. Now Premier can be used to select the color and make it transparent. Letting the video of the track showing 
through. Professionals to use a distinct green or blue color.

Fig.4.1.35: Transparency Settings
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 >ƵŵinancĞ͗ Gray values are keyed out. 

�ůpŚa �ŚannĞů͗ Alpha is the transparent Channel. Adobe Premiere has alpha channels that are added automatically 
in tittles even Adobe Photoshop has alpha channels for Images. 

ditůĞƐ

A superimposed text on a clip or on a color background that uses a alpha channel is called Tittles. Go to Select 
File>New>Title

You can also click at the bottom of the Project window and select Title. In the Title Designer window select 
the type of title you wish to make from the Title Type pull down menu. Options will be Still, Roll, and Crawl. By 
Selecting the “T” tool, click and drag in the window to where and how you want the text to appear.

In the Object style tab you can select options like font, size, justification, etc and also make basic shapes by the 
shape tools in the toolbar. Also customized templates can be chosen to complete all the design. By saving them 
you can use them later.

The white lines are Safe Areas that indicate the width the text must fit in to, if you exceed them it cuts the text. 
After completing the title, close the window and to save the file at chosen location. The title will be in the default 
bin automatically.

Fig.4.1.36: Title Designer
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 ditůĞ oǀĞr ǀidĞo͗ Drag the side of the tittle clip to extend to the length you require and automatic alpha channel 
key is applied by premier. You can then add motion effects to the tittle. Ensure that the tittle clips you are working 
overlap each other.

dĞǆt ZoůůinŐ 

Go to tittle type menu and select Role then using the Text tool make in area that you want to roll a text. You will 
see a scroll bar on a text area if the text goes out of the screen.  Make sure the safe area that’s the inner white 
lines are not exceeded. Once you done inputting the text using the Arrow tool place the text up and continue 
writing you finish then select Crawl option in tittle menu to set scrolling On or Off screen. The saved Rolling effect 
text will be in the last selected bin. Now just drag it to Video 2 track to key over the video. Adjust the length and 
width of the text as require. 

DakinŐ �raǁůinŐ dĞǆt

To make crawling text  select Crawl from the Title Type pull-down menu. Click on the Text tool  and drag an 
area  that will have your text crawling. If you see text extending just use the Arrow Tool to move to the left and 
extend the box as needed. Select Roll/Crawl Options from the title menu and set specifics as to how. Drag this to 
Video 2 and it will be keyed over the video. You can set the width and time for the text roll. Now you can preview 
your text.

ϰ͘ϭ͘ϭϭ ^aĨĞ �rĞaƐ and �oůorƐ
Any software will give technical restriction for the broadcast output and the producer should know these.

There are two areas that are to be aware of: The Safe Action Area is the defined boundaries or edges that cannot 
be exceeded while placing objects or actors, else they will reflect similarly on the television screen. The safe title 
area gives the outlines for the titles or graphics as distortion is usually around the edges. The NTS Safe Colours 
are ones that restrict colour bleeding or saturation on the final output, specifically Red sometimes tends to bleed 
into other colours or graphics. Premier 6.5 gives warning if the colour tends to be unsafe

The actual numbers for a safe 640x480 display are:

•	 Safe Action Area: 81% of screen, 576x432 of 640x480

•	 Safe Title Area: 64% of screen, 509x384 of 640x480
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ϰ͘ϭ͘ϭϮ �oŵpiůinŐ tŚĞ DoǀiĞ
Once you have finished assembling clips you can make a QuickTime or .AVI file of the completed movie. The file 
can run on a CD rom or a harddrive without starting Premiere 

Go to File >Export Movie and adjust settings as required for the format

Select QuickTime File Exporter to make a QuickTime movie for the Web. In the Advanced Settings set your audio 
and video compression preferences. Fine tune the settings in Options after applying your necessary bandwidth. 
Find below some settings:

Hinted track is required for streamed QuickTime movies to stream properly.

You can manipulate compression, frame size, frame rate etc just like the setting window that has been explained 
in earlier unit.

Below are some recommendation however you will have to try out combinations to get best results.

/ntĞrnĞt  ͬ
W W W

PrĞƐĞntationͬ
P ow e r 
P oin t

��ͲZKD 
;ϰǆͿ

��ͲZKD 
;ϮǆͿ

dsͬsidĞo

Frame 
Size

160x120 320x240 320x240 320x240 640x480 (min.)

Frame

Rate

5-10 15-20 15 15 30

Codec(s) Sorenson Sorenson Cinepak, 
Sorenson, MPEG

Cinepak, 
Sorenson, MPEG

Depends n video 
card

Audio 
KHz/bits/ 
Stereo or Mono

11/8/M 44/16/S 44/16/M 22/16/M 44/16/S

Fig.4.1.37: Video Rates
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ϰ͘ϭ͘ϭϯ �ddinŐ KtŚĞr KbũĞctƐ
The following objects can be added to your project bin either by selecting them from the File menu or by clicking 
on the Object icon in the Project window:

�oůor backŐroƵnd

Select a color from the color picker to add a color background. Give the selection a name and then once you see 
it on your project window you can drag it where you want it to be applied on your timeline.

DoǀiĞ �oƵntdoǁn

Follow path File>New>Universal Counting Leader where you can set a 10 seconder countdown to your movie and 
in the dialog box you can choose the background colours, line targets, wipe and numerals as required. You can 
also go to the Project window and select the Object icon for the countdown. Once you click OK it will appear on 
the Project window where you can drag and place it where required.

KŋinĞ &iůĞ

An offline file lets you work on the project till you get the video to use. Like filling the aftermath for the missing 
video. Simply by giving the name to the file, enter the start and end time if known and it will get added to the last 
selected bin in the Project window to be dragged and use when video is got.

�ůack sidĞo

Its just a 5 second black graphic that can place a black break within the created movie as required by dragging and 
placing on the timeline. The length can be decided by pulling its edges as its defaulted to 5 seconds.

�oůor �arƐ

Colour bars help set the colours correctly for the television broadcast. Hence use of these is recommended if your 
video will be on television.
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ϰ͘ϭ͘ϭϰ Dini ProũĞct Ͳ �dobĞ PrĞŵiĞrĞ �^ϲ͘ϱ
Note: Start Premiere 6.5 by double clicking on the icon. By default the Project Settings window will open. We will 
experience the benefit that Premiere provides us of Real time Viewing, hence below the DV – NTSC Real-time 
Preview folder, select Standard 48kHz as project settings. If you don’t see the folder click the small gray triangle 
to open. Click OK to finish and Launch.

Proceed to go to File >Import>Folder. 

Browse in the Adobe Premiere 6.5 application folder and 
select Sample Folder.

Select by the Choose button and the contents of the sample

folder  will be imported into Bin 1 in your Project window
You should see the following files placed in the Sample Folder: Boys.mov, Cyclers.mov, Fastslow.mov, Finale.mov, 
Music.aif, Veloman.eps, and the movie we are trying to recreate, Zfinal.mov.

Before beginning lets see the movie we are trying to work against. Double click on the Zfinal.mov icon and you 
will see a new window open where the movie will start. Watch the movie to understand what we are shooting 
for. Open the window anytime for reference.

A perfect view is required for our timeline. So since our movie is 
upto 30 seconds we will set the Time Zoom Level to 1 second unless 
its already set to the same to be able to see the movie without 
having to scroll. Go to the Timeline window and Select 1 second 
where you will see numbers on the top.

There will be automatic one second time interval. You can choose 
the Time Zoom to adjust level as required. 

Fig.4.1.38: Import a Video

Fig.4.1.39: Project Creation

Fig.4.1.40: Inserting Audio
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The finished movie starts with boys.mov clip. Double click on the boys. Mov in the Project window to open it in 
seperate window. You will notice that the clip is longer than the one you see in the final movie. Hence we will drag 
it in the timeline and edit it according to our requirement. Use the playhead that is a blue downward-pointing 
arrow to move to about 00;00;04.03. After which click on the right-facing bracket at the bottom of the clip 
window. Which is: } This will set an outpoint for the video. The play area will become yellow, stating the cropped 
area of the clip. Similarly set an inpoint for the clip by clicking on the left-facing bracket, near the play button but 
we don’t require it in this clip. Now drag the video from the clip window into Video 2 track. The track will turn 
black accepting the keying. 

Let us proceed to add the audio track. Open Music.af in the 
Project window and drag it to the Audio 1, when you see it 
turning black it is ready to take the audio in. By clicking on 
the triangle you see close to Audio 1 you can see track sound 
wave. This will help synchronize the sound and the video. 

 

Fig.4.1.41: Add Soundtrack

Fig.4.1.42: Movie Clip on Monitor
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Since our video is little shorter, we will lengthen its duration 

Just a little by using the Rate Stretch Tool.  You should see it in

your tool bar otherwise just click and hold down in the area marked 
above in red. Our required video length is 00:00:05:18

To have the clip timing as is inaccurately see the clip’s length in the

timeline, select show info option in the timeline ,the Info 

Select the Rate Stretch Tool and position it over the right edge of the 
Boys.mov in the Timeline window.

In our reference movie the video also fades in for applying this setting select the small triangle next to Video 2 
to see control icons. Select the red square with the diagonal line passing through it. There will be a red line (the 
Opacity Rubber Band) that appears under the clip. This will controls the opacity of the video and is not available 
on the Video 1A and Video 1B tracks hence we have used it on VIDEO 2 Track. Keep it at 100%. By clicking on your 
arrow tool, then click on the red line till 1 1/2 seconds into the clip at the third tick mark. A keyframe will appear 
on the red line. Now pull the point to the left of your new keyframe down to the bottom so that the red line will 
angle up to your new keyframe. This will set the opacity to 0% at the start of the clip and will gradually change to 
100% opacity at 1 1/2 seconds letting the clip fade in. Wasn’t that simple?

 A tools icon will appear there. While looking at the Info window, drag the right side of the cursor till 00:00:05:18. 
Now we have increased the length of the movie and it will play slower. Now the movie and audio will have 
synchronized. Watch it to confirm.

Fig.4.1.43: Monitor Tools

Fig.4.1.44: Movie Info

Fig.4.1.45: Merging Audio and Video

Fig.4.1.46: Video Fades up from Black
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Open a new clip (fastslow.mov.), put in point as 00:00:00:00 & 
00:00:04:17 as out point. Drag the set video to the timeline in 
the Video 1B track but just by 1 second overlap it in Video 1A.

Watching the Info window closely, to the left of the clip start 
at around 00:00:07:00 for where you are adding to the end at 
point when Audio 1 track changes.

Go to Windows> Show Transitions to add the transition we want. Click the grey icon adjacent to Dissolve folder, 
select Cross Dissolve. A dissolve example will open. Now adjust the start and end time on each movie clip for 
starting & ending dissolve with, however we will leave it at starting 0% and ending at 100%. Close the Cross 
Dissolve window. Pull cross dissolve icon (from Transitions window) to a position on transition track in between 
tracks 1A & 1B of Video. It would move in overlap location in between two clips and automatically fill up the 
space for overlap length of the two clips.

With Premier since we can preview the transitions we have without rendering, let us see what we have done till 
now. Begin with moving your cursor to 00:00:00, then under the Timeline Menu and Select Preview to see how 
its looks in real time. Stop the preview once the video stops. Else the soundtrack will keep playing. However this 
is just an idea as to how the finished output will look but there still have to be formal renders to be made to get 
the finished look.

Move to the next clip cyclers.mov, open it by a double click so that it opens in the clip window. Make a right 
bracket (outpoint) at 00:00:02:21 and then drag it onto the Timeline in the Video 1A track. Place is enough to 
have it close to the right of the clip you have placed in the Video 2 track. It will fall into place there.

Fig.4.1.47: Adding Next Clip

Fig.4.1.48: Adding Next Clip

Fig.4.1.49: Preview Fig.4.1.50: Rendering Work Area
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Move on to double click on the fastslow.mov to open in window. Place the in point at 00:00:04:18 location & out 
point to be at end. Move clip down to Video 2 track at point 00:00:11:18 on timeline. Make sure that clip is in 
video 2 or higher for adding transparency. Now we will proceed to add fading effect, that is transparency.

See that the sound wave is shown in the Audio track 1, else click on the triangle near to Audio 1 and select the 
first icon to see it. See if the last video clip aligns with the Video 2. If it is a subdued part then the video and audio 
will sync. The clip is also shorter to cover the length of the sound track. By selecting the Rate Stretch Tool  to drag 
the right side of the clip till it can be placed where the music will stop suddenly. This will slow the video clip down, 
but that’s the effect we want here.

Fig.4.1.51: Movie on Monitor
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At this section there is a fade to black in the final movie, so in the Video 2 
track, ensure you see the opacity rubber band. Click at 00:00:14.14 point 
and move keyframe to end  to bottom for the red line to come down to 0% 
opacity, like the earlier clip.

The next clip is the finale.mov and this does not require any editing, hence we will just drag and drop it from the 
preview window to the Video 1B track. At the Window menu select Show Video Effects to blur the clip. From the 
Blur folder, choose Gaussian Blur, and the move it on clip on 1B. When clip will blink blue your file will be dropped 
on with the filter. The filters, audio and video get applied directly on the clips whereas the transitions fit between 
the clips automatically. When the green line shows above the clip the filter will have applied. Get the rubber band 
for the Video 1B by clicking the triangle near the video. 2 white boxes will appear in the track.

 

Fig.4.1.52: Audio and Video Syncing

Fig.4.1.53: Fade-up Point on a Video

Fig.4.1.54: Adding the Last Clip
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We will not apply the Gaussian Blur on some of the clicks to avoid it affecting the whole clip, only towards the end 
of the clip. On the timeline of finale.mov of Video 1B drag the left white square till 00:00:24:14 Next move the 
blue traingle to about 00:00:26:00 and add keyframe. You will see a white diamond  appear and the 2 triangles 
have changed into diamonds as well.

Click on the diamond that you made at 00:00:26:0. Go to 
Windows>Show Video Effects and drag the Blur control for the 
Gaussian Blur to 8.2. Set Blur at 0.0 for the first diamond (at 
00:00:24:14). This causes the blur to occur gradually between the 
two diamond.

Since the clip is not as long as the audio track, we will lengthen it. Instead of playing with the clip’s speed we will 

stretch the last few frames. Put your cursor at about 00:00:30:00. With the help of Razor tool,  cut the clip 
at where you have the cursor. It will separate the clips in two. Using the Rate Stretch tool stretch the last clip out 
till it aligns with the end of the audio. We are almost there now.

Next we will add the finishing section of the spinning logo. Select clip Veloman.eps and drag it down down to the 
Video 2 track starting at around 00:00:24:14. Drag the right side of the clip with your arrow tool till it moves to the 
last. For setting transparency, choose box adjacent to transparency in Effect Controls window. Select White Alpha 
Matte next to Key Type and the white alpha matte will make the white background become transparent. Check if 
the page curl icon is selected to see the Veloman logo appear in the background over the bikers.

Fig.4.1.55(a): Setting Gaussian Blur to Keyframes

Fig.4.1.55(b): Setting Gaussian Blur to Keyframes
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Go to the Motion Settings window appears with the Video 2 selected and Select white square which is to left of 
Visible Area by clicking on it. Put Zoom value to 15% and set the value by use of return key. The logo will get small. 
Now move the logo at the Visible Area edge.

Fig.4.1.56: Transparency Setting

Fig.4.1.57(a): Motion Setting

Fig.4.1.57(b): Motion Setting
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Click on centre of dark black line in Visible Area  to add another keyframe  and move it to the middle of visible 
area. Set the Zoom to 100%. The logo will increase when it gets in the middle and reduce towards the right. We 
require it in the middle for a bit, so set Delay to 15%. Click the OK button.

Go to Preview to see your finished video.

Fig.4.1.57(c): Motion Setting

Fig.4.1.58: Preview the Video
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hE/d ϰ͘Ϯ͗ �Ƶdio and sidĞo &orŵatƐ

The completion of this unit will enable:

1. Familiarise with the different types of Audio and Video formats

2. Use the different formats relevantly

3. Familiarise with containers, codec and bit rate

ϰ͘Ϯ͘ϭ sidĞo &orŵat

hnit KbũĞctiǀĞƐ 

Video formats have two technologies that are distinct and different: containers (sometimes called wrappers) 
and codecs (shortform coder/decoder). Video formats are difficult to understand as codecs are used inside of a 
container.

tŚat iƐ a �ontainĞr͍ 

The container tells us about the file structure like where and how they are stored in different pieces and 
interleaved. Also tells us what codecs are used by which pieces. It can tell us whether an audio codec or video is 
used. It packages the video and its components (audio/metadata). 

tŚat iƐ a �odĞc͍ 

A short for "coder/decoder" is called Codec and is a method of encoding video or audio files to byte streams. It 
is apex component to determine the quality.

Hoǁ do tŚĞǇ ǁork toŐĞtŚĞr͍ 

The container can be thought of as the file itself and the contents become codecs. A good format can have a lot of 
codecs. Eg: MOV, .MP4 and .AVI containers can hold variety of codec data. The quality of the video is dependent 
on codec. 

tŚǇ iƐ it Ɛo coŵpůicatĞd͍ 

This may seem simple but it is not as the common terms may be confusing. To make it even difficult, software 
companies try to simplify their documentation and instructions by neglecting this complicated difference. The 
outcome is that people assume that phrases sucs as giving MOV or MP4 file are fine to talk about video. Mpeg—4 
define both container & codec which makes it more confusing. 
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ϰ͘Ϯ͘Ϯ tŚat sidĞo &orŵat ^ŚoƵůd / hƐĞ͍

ϰ͘Ϯ͘ϯ >iƐt oĨ DoƐt �oŵŵon �odĞcƐ

&iůĞ ƐiǌĞ and ƋƵaůitǇ

�iŐitaů ^toraŐĞ ^pacĞ͗ To understand the requirement of storage space of a project will depend on the device 
you are using and the quality used to record. Digital video requires around 200 MB p/m of footage, perhaps upto 
12 GB p/h.

&raŵĞƐ pĞr ^Ğcond͗ Increase in the FPS will outcome a smoother image by having more images included. The 
standard for FPS is 29.97. Reducing the FPS will make the video abrupt and not smooth

sidĞo �itratĞ͗ Bitrate is a measurement of the number of bits that are transmitted over a set length of time. Your 
overall bitrate is a combination of your video stream, audio stream & metadata in your file with the majority 
coming from your video stream. The higher the bit rate the better the quality the bigger it will be.

ZĞƐoůƵtion͗ The amount of pixels that are there in the images of the video is referred to as resolution. It states if 
your video is SD or HD. The image is clear and big with higher resolution.

•	 DP�' (Motion Picture Proficient  Group): there are 3 types, MPEG 1, 2, and 4.

•	 DP�'  Ͳϭ͗ It is a common choice for web and traditional, efficient method (at least up to 352x240), 

•	 DP�' ͲϮ͗ A MPEG format that has good level of compression. (720x480.) Utilized in HDTV, DVD, and SVCD.

•	 DP�' Ͳϰ͗ A family of codecs, some are open and others are Microsoft proprietary. 

•	 H . 2 6 4 :  It is component of MPEG- -4 codec which is widely web based used codecs for videos.

•	 DP�' ƐpinoīƐ͗ mp3 (for music) and VideoCD.
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•	 D:P�' ;Dotion :P�'Ϳ͗ A codec comprising of a stream of JPEG images popularly for digital cameras,and 
effective for editing videos, however has low compression quality and not fit for web distribution. 

•	 �s ;�iŐitaů sidĞoͿ͗ Fixed at 720x480 @ 29.97FPS, or 720x576 @ 25 FPS and utilised for video taken from 
firewire with a video camera. It lacks high compression parameters. 

•	 tDs ;tindoǁƐ DĞdia sidĞoͿ͗ A group of Microsoft proprietary video codecs. From version 7, it has utilized 
a specific format of MPEG4. 

•	 ZD ;ZĞaů DĞdiaͿ͗ a closed codec made by Real Networks used streaming video and audio. 

•	 �iǀy͗ primarily used in early ASF (incomplete early MPEG- -4) codec within an AVI container; DivX 4 and 
further are a more full MPEG- -4 code. It does not restrict resolution.  It cannot be found easily for Mac and 
Windows players and needs more horsepower to play than mpeg1, but reduced for mpeg2. 

•	 ^orĞnƐon ϯ͗ Apple's proprietary codec, widely used for distribution ofmovie trailers (inside a Quicktime 
container). 

•	 YƵicktiŵĞ ϲ͗ Apple's implementation of an MPEG4 codec.

•	 R P 9 :  a very efficient streaming proprietary codec from Real (not MPEG4).

•	 tDsϵ: a proprietary, non- -MPEG4 codec from Microsoft.

•	 KŐŐ dŚĞora͗ A relatively new open format from Xiph.org.

•	 �irac͗ A very new open format under development by the BBC.

ϰ͘Ϯ͘ϰ >iƐt oĨ DoƐt �oŵŵon �ontainĞrƐ

ϰ͘Ϯ͘ϱ ^aŵpůĞ �it ZatĞƐ

•	 �s/ ;�Ƶdio sidĞo /ntĞrůĞaǀĞͿ͗ A Windows' standard multimedia container. MPEG- -4 Part 14 (known as .mp4): 
is the standardized container for MPEG- -4. FLV (Flash Video): the format used to deliver MPEG video through 
Flash Player. MOV format: Apple's QuickTime container.

•	 K''͕ K'D Θ K's͗ Open for all and standardized containers.

•	 D<s ;DaƐtroƐkaͿ͗ Open format- -specific container noticed while downloading anime. 

•	 sK� ;�s� sidĞo KbũĞctͿ͗ It's DVD's standard container.

•	 �^&͗ A Microsoft format designed for WMV and WMA—files can end in .wmv or .asf

•	 16 kbit/s – videophone quality (minimum necessary for a consumer- -acceptable “talking head” picture using 
various video compression schemes)

•	 128 – 384 kbit/s – business- -oriented videoconferencing quality using video compression

•	 1.5 Mbit/s max – VCD quality (using MPEG1 compression)

•	 3.5 Mbit/s typ — Standard- -definition television quality (with bit- -rate reduction from MPEG- -2 compression)

•	 9.8 Mbit/s max – DVD (using MPEG2 compression)
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ϰ͘Ϯ͘ϲ �Ƶdio &iůĞ &orŵatƐ

•	 8 to 15 Mbit/s typ – HDTV quality (with bit- -rate reduction from MPEG- -4 AVC compression)

•	 19 Mbit/s approximate — HDV 720p (using MPEG2 compression)

•	 24 Mbit/s max — AVCHD (using MPEG4 AVC compression)

•	 25 Mbit/s approximate — HDV 1080i (using MPEG2 compression)

•	 29.4 Mbit/s max – HD DVD

•	 40 Mbit/s max – Blu- -ray Disc (using MPEG2, AVC or VC- -1 compression)

•	 �/&& �Ƶdio /ntĞrcŚanŐĞ &iůĞ &orŵat Commonly used audio file formats in Macintosh and Windows. It meets 
requirements of most CD writers accept AIFF files when writing a Red Book audio CD. 

•	 t�staǀĞ Ͳ Windows native audio format.

•	 �h ^Ƶn aƵdio Ĩorŵat - Primary format for Sun/UNIX systems, and commonly used on the Internet.

•	 HandůĞƐ ϴͲ and ϭϲͲbit sound is not compressed, and μLaw encoding.

•	 DPϯ DP�'Ͳϭ �Ƶdio >aǇĞrͲϯ it has a high rate of compression and used widely on web for audio files. Many 
websites provide download in this format. It is good quality in small size (most don’t adhere to copyright rules). 
Digital audio is ideally made by taking 44,100 16-bit samples p/s (Hz) of the analog audio signal, meaning that 
1 sec of CD-quality sound needs 1.4 million bits (upto 176K bytes) of data. Understanding people’s perception 
of quality MP3 developers developed a compressed algorithm that compresses data amount of sound that 
consumers cannot catch. MP3 is currently the most widely used format in the audio encoding business 
developed under Motion Picture Experts Group (MPEG) and formalized by the International Organization for 
Standardization (ISO).

•	 ^�Ϯ ^oƵnd �ĞƐiŐnĞr // Ͳ Primary to DigiDesign’s Sound Designer pro audio software. Native to Macromedia 
DECK II and other formats.

•	 ^E� ^oƵnd ZĞƐoƵrcĞ ĮůĞ Ͳ Apple-basic format for sound file as early as first produced Macs. Rarely used 
today

•	 DKs YƵickdiŵĞ ŵoǀiĞ ĮůĞ Ͳ Audio-only QuickTime files are rarely essential.

•	 ^� ^oƵnd�dit Ͳ an 8-bit file format used in to old versions of SoundEdit. It has sound data in the data fork, 
and loopback location, selection (cursor) place, waveform color, labels, recorded pitch setting, and playback 
pitch setting in the resource fork. 

•	 ^�ϭϲ ̂ oƵnd�dit ϭϲ Ͳ Native format of SoundEdit 16, has  tracks, cue points, spectral data, and perhaps System 
7 information, and also the information in the original SoundEdit format. 

•	 ^ǇƐtĞŵ ϳ ^oƵnd Ͳ a format launched in version 7 of the MacOS, allows desktop “double-click” playback.
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ϰ͘Ϯ͘ϳ /ŵportant dĞrŵƐ Ĩor �Ƶdio and sidĞo
•	 �it dĞptŚ͕ ƐaŵpůĞ ƐiǌĞ or rĞƐoůƵtion Ͳ many terms to state the number of bits utilized to state each sample of 

an audio signal. Std bit depths are 8, 16, and now 24. The higher the bits in each sample, the more “steps” can 
be shown, that’s why the more accurate the digital audio that represents the original (analog) audio signal. 

•	 �ata ratĞ Ͳ the number of data that needs to be conveyed at each second to copy a digital audio or video 
signal. Common for digital video, an extreme rate of data can cause a  jerky, uneven playback, specifically 
with slow transmission media, eg earliest CD-ROM drives and low processing computer systems.

•	 �ĞcibĞů ;d�Ϳ Ͳ a logarithmic scale that measuring the volume of sound. If two sounds have 10dB difference 
between them  in volume, it states that sound is  ten times loud in comparison to other. Frequency means 
cycles p/s, referred as Hertz, stating the rate of change of a sound wave. The more the frequency (the higher 
cycles per second), the increase in pitch of sound. 

•	 HĞrtǌ͕ kiůoHĞrtǌ ;HǌͿ Ͳ named after an early researcher for sound, Hertz means “cycles per second”, and 
expresses audio frequency. One Hz is a full cycle of a sound wave p/s. Pitch is denoted with higher or lower 
frequency. Frequencies are also explained in kilohertz (thousand cycles p/s), i.e“22 Khz”. The “concert A” of 
modern symphony orchestras is 440 Hz. 

•	 ^aŵpůĞ Ͳ one “snapshot” of an audio waveform or video signal at an instant in time. Digital audio and video 
consist of stream of samples when played back, proportion the original data. In talkable terms we call it 
quanta. 

•	 ^aŵpůinŐ ratĞ Ͳ the total samples p/s that are got of an audio signal to get a digital audio file, shown in 
kiloHertz (kHz). Commonly used rates are 11.025 kHz, 22.050 kHz, and 44.100 kHz. The more the sampling 
rate, the finer the sound quality. 

•	 taǀĞůĞnŐtŚ Ͳ it states how long a single cycle of an audio signal or waveform. It is the inversely correlated to 
Frequency. Which means, a lengthier wavelength states a lower frequency; a smaller wavelength, a higher 
frequency.
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hE/d ϰ͘ϯ͗ ProũĞct dĞƐtinŐ

The completion of this unit will enable:

1. Paraphrase how to test a deliverable output.

ϰ͘ϯ͘ϭ dĞƐtinŐ oĨ a DodĞůͬProũĞct
dĞƐtinŐ

Generically testing means checking and evaluating the work that has been done to check its functionality against 
the used knowledge and research. With  computer 3D project development, testing determines whether the set 
objectives are met. Example, many times, product objectives are tested by end product users. When the design is 
finished, animation and modelling is followed by testing the units by editor or animator. at the component level 
by team involved; and at the system level when all components are combined together. At early or late stages, a 
product or service may also be tested for usability.

dĞƐt půanninŐ procĞƐƐ

Below are steps that are to be followed to check whether the specification for the given project are being met 
correctly:

^taŐĞ ηϭ͗  ZĞǀiĞǁinŐ tŚĞ rĞƋƵirĞŵĞntƐ͗ The first step that analyzes the given requirement by identifying items 
that will be tested. They are on the basic of end user consumption and therefore are measurable and in depth 
concepts. These are also called as functional requirements that describe the specifications of the model or the 
product. There can also be some non-functional requirements recognized as performance or end to end model 
components’ interaction. People need to be aware of the business goals to define requirement properly. The 
documented analysis is then circulated to gather feedback and get a final sign off to proceed. 

^taŐĞ ηϮ͗ dĞƐt �ĞtĞrŵinantƐ͗ The test determinants are similar to requirement analysis phase and mostly 
considered as a single activity. Once the requirements are out, the test team determines what items are to be 
tested and what not. This activity also determines teams that cover testing.

For example: 1 team is resourced for FVT (Function Verification Test) and SVT (System Verification Test) will have 
a single scope for testing, and globalization can or cannot be applied by FVT etc.

If the project requires automation is also calculated here. A clear scope provides a clear picture to understand 
the what and how of testing phase and also evaluating the teams work.

hnit KbũĞctiǀĞƐ 
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^taŐĞ ηϯ͗ �ĞǀĞůopinŐ tĞƐt ƐtratĞŐǇ͗ Once the test team has gathered all the requirements and understood the 
goals they set out a high level document called the test strategy document that defines the testing approach to 
achieve the test objectives. 

The content of the test strategy document has the parameters of the testing, the approach, core requirements 
from resource teams, tools required for testing, the metrics identified, risks management, reporting and tracking 
mechanisms, etc.

^taŐĞ ηϰ͗ �ĞtĞrŵininŐ tooůƐ͗ Depending on whether automation is possible and whether CLI (Command Line 
Interface) or GUI automation is targeted, the corresponding tools will be identified.

There are tools identified for test management which will assist in creating and assigning tasks, track the test 
progress, identify hurdles and generate reports stating progress. 

^taŐĞ ηϱ͗ �ƐtiŵatĞ tŚĞ tĞƐt Ğīort and tĞaŵ͗ Effort estimation of team helps balance resources well and optimizes 
their outcome for the project. The determinants are the size and skill of team and importantly the attitude to 
meet given schedules.

It is compulsory to have the effort estimations align with the interest of the resources towards outcome.

^taŐĞ ηϲ͗ �ĞĮnĞ tĞƐt ƐcŚĞdƵůĞ͗ After the line items identification in clear broken down arrangement the size 
components of the complete project for the specified piece of work, a calculable test schedule needs to be 
created based on all the and the dedicated testers. 

^taŐĞ ηϳ͗ �nabůĞŵĞnt půan͗ The team should be technically competent to follow and respect the overall test 
process for the project. 

^taŐĞ ηϴ͗ �naůǇǌinŐ and PrĞparinŐ tŚĞ tĞƐt ĞnǀironŵĞnt͗ Know and make available the required infrastructure 
for testing the system and initiate all the requests to get the needed hardware, software and networking 
components that support the test environment. This monitors stability overall of the environment and affects 
the end result a lot. 

^taŐĞ ηϵ͗ �ĞtĞrŵinĞ tĞƐt ŵĞtricƐ͗ Test meters are level  set measurable metric and are a quantifiable quality 
testing method. They show any areas of improvement. Commonly for quality audit purposes, the metrics are 
direct indicators of the product and process quality. 

^taŐĞ ηϭϬ͗ �rĞatĞ tŚĞ ŵodĞů tĞƐt ƐtrƵctƵrĞ͕ rĞǀiĞǁ and approǀaůƐ͗ This document  should cover the what, when 
and how of testing and is the official technical document for methodical approach.



ϱ͘   Daintain torkpůacĞ 
HĞaůtŚ and ^aĨĞtǇ

Unit 5.1 - Maintain Workplace Health and Safety

D�^ ͬ E ϬϭϬϰ
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At the end of this module, you will be able to:

•	 Understand and comply with the organization’s current health, safety and security policies and procedures.

•	 Understand the safe working practices pertaining to own occupation.

•	 Understand, the norms and policies of the government related to health and safety, which also includes some 
emergency procedures for accidents, fires and illness or others may involve evacuation of the premises

•	 Identify the people responsible for health and safety in the workplace, including those to contact in case of 
an emergency.

•	 One should be fully aware about the security measures such as fire alarms, safety exit, medical and first aid 
availability.

•	 Identification of aspects for potential risk at workplace is must for owns and others health and safety.

•	 One should ensure health and safety of others and himself at workplace through precautionary measures. 

•	 Identification of opportunities related to health, security and safety should be done and recommended to 
the designated person.

•	 Identify and correct risks like illness, accidents, fires or any other natural calamity safely and within the limits 
of individual’s authority 

<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
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hE/d ϱ͘ϭ͗ Daintain torkpůacĞ HĞaůtŚ and ^aĨĞtǇ

After the completion of the unit, the major things covered will be:

1. Making certain of own health and safety, and that of the other people around by taking necessary 
precautionary measures.

2. Recognize the risks like illness, accidents, fires or any other natural calamity and correct them ensuring the 
limits of individual’s authority.

3. Recognize the people in charge of health and safety in the workplace, including those to contact in case of 
an emergency.

ϱ͘ϭ͘ϭ /ntrodƵction
Emergency evacuation is needed when staying within the building not safe anymore. Every organization has 
an evacuation procedure. Every organization has a safe place within the organization compound or outside the 
organization compound where all employees are expected to assemble in case of an emergency evacuation. The 
team leader guides the team and takes them to safe place. It is very important in these cases, to assemble at the 
safe area immediately.

If you do not reach the safe area on time, the team leader who is responsible for your safety will send someone 
to look for you. This will put the other person's life in danger.

�onditionƐ Ĩor �ǀacƵation 

Emergencies which require evacuation include: 

•	 Destructive burning objects

•	 Sudden Violent Explosions (Explosions)

•	 Overflowing conditions of water (Flood)

•	 Violent ground shakes (Earthquake)

•	 Storms or violent wind calamity (Hurricanes)

•	 Cyclones and tornados

•	 Toxic material releases

•	 Civil disturbances

•	 Workplace violence

Every company has:

•	 �n ĞǀacƵation poůicǇ͘ All the TLs are responsible for informing their employees about it. When the TL is 
informing you about these details, pay attention. This negligence could cost lives.

•	 � dĞƐiŐnatĞd půacĞ Ĩor ĞŵĞrŐĞnciĞƐ͘ Ensure that you know where it is.

•	 � ͞bƵddǇ ƐǇƐtĞŵ͟ Ĩor indiǀidƵaůƐ ǁitŚ ƐpĞciaů nĞĞdƐ or diƐabiůitiĞƐ͘ If you are a buddy to someone, en¬sure 
that your buddy is safely out of the premises with you. 

Fig.5.1.1:  Conditions for Evacuation

hnit KbũĞctiǀĞƐ 
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•	 &ůoor půanƐ ǁitŚ ĞǀacƵation roƵtĞƐ in ǁork arĞaƐ͘ Ensure that you understand it so that you can use it in 
time of need. 

•	 �ƐƐĞŵbůǇ arĞaƐ͘ These are the areas where you are required to assemble after evacuation. 

•	 PĞriodic ĞǀacƵation driůůƐ͘ Ensure that you pay attention during those drills. You need to save your life and 
you can be helpful in saving someone else’s life too. 

ϱ͘ϭ͘Ϯ Dock �riůůƐͬ�ǀacƵationƐ

ϱ͘ϭ͘ϯ DĞdicaů �ŵĞrŐĞnciĞƐ

Fire safety and evacuation does the duty of planning outline duties of the staff and the responsibilities at the 
time of emergency. For ensuring the awareness of the duties and responsibilities of the staff ongoing training is 
required. Fire drills serve as an opportunity for staff members to demonstrate, under simulated fire conditions, 
that they can perform those duties and responsibilities safely and efficiently. It’s also a time for them to show 
that they are aware of defend-in-place strategies and can take advantage of your facility’s fire safety features and 
egress facilities to protect the people in their care.

In order to evaluate staff response to a stimulated responsibility fire drills 
are more than an exercise for them. It is a test for ones safety from fire 
at the facility. Fire drills may not always be smooth. That’s okay, so long 
as staff and management learn from them and correct mistakes made. 
It’s important, therefore, that there be a critique of each drill so that any 
problems encountered can be addressed. Perhaps the problems are due to 
incomplete or outdated fire safety/evacuation plans. Perhaps there’s a need 
for additional staff training.

The two most important aspects for fire safety and preparedness are 
following:

First is an action plan in case of any emergency, which details the measures 
when fire occurs

Second is the prevention plan, which illustrates methods for prevention 
during fire.

You need to participant in fire drills arranged by organization for your personal 
safety and also for others safety. These drills help you in understanding the 
safety signage and action plan of organization in case of fie.

Everyone plans for emergencies. That is the reason why we keep a first aid kit with ourselves. At work, however 
one is exposed to a lot of stress and physical activity. This could lead to certain medical emergencies. It’s better to 
be prepared with the first aid measures and knowledge of implementing them on ourselves and on others. This 
module equips you with that information. Pay attention to these medical emergency procedures to understand 
how to conduct you in theses crucial movements. Pay attention during these sessions. You might be able to save 
your own and your friend lives.

Fig.5.1.2:  Mock Drills



85

Editor

ϱ͘ϭ͘ϯ͘ϭ �ĞaůinŐ ǁitŚ DĞdicaů �ŵĞrŐĞncǇ
A medical emergency is an accidental injury or a medical crisis that is severe. These could be situation where: 

•	 The person is unable to breathe

•	 Heart failure and strokes

•	 Severe bleeding

•	 Shock

•	 PoisoningBurns

A medical emergency requires your immediate attention, sometimes even before you call emergency services 
for help. 

It is crucial that you know the Emergency Medical Service (EMS) number, for your own safety and the safety of 
others. 

D O  N ot 

•	 Give the victim anything to eat or drink. 

•	 Restrain the victim. 

•	 Splash or pour any liquid on the victim’s face. 

•	 Move the victim to another place (unless it is the only way to protect the victim from injury). 

�ůĞĞdinŐ 

•	 Use a pressure bandage to the wound and apply pressure with the help of your palm.

•	 Elevate the wound to slow the bleeding.

•	 Pressure points when necessary apply additional pressure to help reduce bleeding.

&aintinŐ

•	 Fainting is a brief loss of consciousness that is due to a momentary reduction of blood flow to the brain.

•	 A brief loss of consciousness causing the casualty to fall to the floor.

•	 A slow pulse.

•	 Pale, cold skin and sweating.

�aƵƐĞƐ oĨ ĨaintinŐ͗

•	  Less intakes of food and fluids which causes dehydration.

•	  Low blood pressure.

•	  Lack of sleep.

•	  Over exhaustion.

&irƐt �id Ĩor &aintinŐ͗ 

•	 Allow the victim to rest on his/ her back and pull his legs about heart level.

•	 Check the victim’s airway to ensure it is clear.

•	 Be aware of the patients breathing, coughing, or movement.

•	 Loosen clothing (neck ties, collars, belts etc.). 

•	 Call for EMS after waiting for one minute for to patient to gain consciousness.



86

Participant Handbook

^Śock 

Shock is a phenomenon which is caused due to the failure of circulatory system which leads to insufficiency   of 
oxygen in the tissues. It treatment does not reach in time, vital organs may fail, which may cause death in worst 
condition. It is worst at time of fear and pain.

&irƐt �id Ĩor ƐŚock͗ 

•	 Keep the victims lying down (if possible).

•	 List the leg upward for about 10 to 12 inches and see if there is any back injury or broken bones.

•	 Keep the body of the victim covered to maintain the body temperature.

•	 Allow fresh air and space to the victim.

•	 Place the victim on his/her left side if he/she starts vomiting.

•	 Loosen restrictive clothing

DƵƐcůĞ �raŵpƐ 

•	 To counter cramps stretch the affected muscle.

•	 Firm massage to the cramped muscles may help

•	 Moist heat to the cramp might be beneficial.

•	 Call for medical help if the same persists.

•	 Rest- avoids movements and activities that cause pain.

•	 Ice- helps reduce pain and swelling.

•	 Compression- light pressure from wearing an elastic wrap or bandage can help reduce swelling

•	 Elevation- raising the affected limb about the level of the heart reduces pain and swelling.

&ractƵrĞƐ 

A fracture is a break or crack in the continuity of the bon

�iƐůocation

A dislocation is the displacement of one or more bones at a joint. It occurs usually in the elbow, shoulders,        
finger, thumb, and the lower jaw.

&irƐt �id Ĩor �iƐůocationƐ Θ &ractƵrĞƐ͗

•	 Immobilize the effected part.

•	 Stabilized the effected part

•	 Use a cloth as a sling.

•	 Use board as a sling.

•	 Carefully transfer the victim on a stretcher.

•	 Call a doctor.
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ϱ͘ϭ͘ϰ &irƐt �id
First-aid boxes should be clearly marked and located so that they are 
Readily accessible in an emergency. They should not be more than 
100 meters away from any place on the work site. Ideally, such kits 
should be near a wash-basin and in good lighting conditions. Their 
supplies need to be regularly checked and replenished. The contents 
of a first-aid box are often regulated by law, with variations according 
to the size and the likely industrial hazards of the enterprise.

A typical basic kit may include the following items in a dustproof and waterproof box: 

•	 Sterile bandages, pressure bandages, dressings (gauze pads) and slings. These should be individually wrapped 
and placed in a dustproof box or bag. Sufficient quantities of the different sizes should be available at all 
times to treat small cuts and burns. Medical adhesive tapes (strip plaster) for fixing bandages and dressings 
are also needed.

•	 Cotton wool for cleaning wounds 

•	 Scissors, tweezers (for splinters) and safety pins 

•	 An eye bath and eye wash bottle 

•	 Ready-to-use antiseptic solution and cream 

•	 Simple over-the-counter medicines such as aspirin and antiacid

•	 A booklet or leaflet giving advice on first-aid treatment

First aid requires some training, but this is not difficult to arrange in most places. The names and location (including 
telephone number) of those responsible for first aid should be put on a notice board. Worker involvement, 
especially for emergency situations, is strongly advised and everyone should know the procedures for obtaining 
medical assistance. Small establishments without their own facilities should keep contact with a nearby clinic or 
hospital, so that the time between the occurrence of an accident and medical assistance is very short, preferably 
much less than 30 minutes. Transport to the clinic or hospital should also be pre-arranged. An outside ambulance 
may be called in, if necessary. It is also desirable to have a stretcher available.

Fig.5.1.3:  First Aid Box
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ϲ͘   ̂ oŌ ^kiůůƐ and 
�oŵŵƵnication ^kiůůƐ

Unit 6.1 - Introduction to the Soft Skills

Unit 6.2 - Effective Communication

Unit 6.3 - Grooming and Hygiene

Unit 6.4 - Interpersonal Skill Development

Unit 6.5 - Social Interaction

Unit 6.6 - Group Interaction

Unit 6.7 - Time Management

Unit 6.8 - Resume Preparation

Unit 6.9 - Interview Preparation
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At the end of this module, you will be able to:

1. Understand the use effective Communication as an important tool in your workplace.

2. Make effective Communication with co-workers and Peers 

3. Understand the use of basic reading and writing skills in the workspace 

<ĞǇ >ĞarninŐ KƵtcoŵĞƐ 
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ϲ͘ϭ͘ϭ tŚat iƐ a ^oŌ ^kiůů͍

ϲ͘ϭ͘Ϯ �oŵponĞntƐ oĨ ^oŌ ^kiůůƐ

hE/d ϲ͘ϭ͗ /ntrodƵction to tŚĞ ^oŌ ^kiůůƐ

At the end of this unit, you will be able to:

1. Understand what it means and the importance of soft skills in work place 

2. Understand the importance of work readiness 

U n it KbũĞctiǀĞƐ 

Soft skill essentially describes the ability and attributes of the 
individual to interact and socialize with people around. Soft 
skills is very important for a successful hairdresser or a makeup 
artist. It is a term which is used to depict the hairdresser or a 
makeup artists emotional quotient, personal habits, optimizing, 
friendliness towards other colleagues or clients, social graces 
etc. Soft skills add on to the skill that the hairdresser or the 
makeup artists possess. Apart from the services provided to 
the client the manner in which the employee interacts with the 
client makes a lot of difference in the client satisfaction.

Soft skills deal more on who we are than how much of skills 
the employee possesses. For example the hairdresser needs 
to be an active listener, empathetic, understanding, and soft 
towards all the clients. This is irrespective of how much skill the 
employee possessors. 

Soft skill is also important for the employee to be happy in the working environment. 

•	 �daptabiůitǇ͗ This is the ability of an individual to adopt to change in the environment.

•	 �ŵotionaů ^trĞnŐtŚ͗  This is about managing ones emotions especially emotions like anger frustration and 
excitement.

•	 >ĞadĞrƐŚip YƵaůitǇ͗ It’s the ability to manage conflicts and difficult situation in professional and personal 
environment. 

•	 dĞaŵ PůaǇinŐ �biůitǇ͗ At the end of the day the work needs to be done and its best done where everybody 
works as a team and help each other out.  

•	 �ĞciƐion DakinŐ͗ There will be many instances for a hairdresser/ make-up artist to make important decisions 
to ensure that the client is satisfied and the organization grows. The ability to take the right decisions in 
various situations is important for the artists. 

Fig.6.1.1: Soft Skills 
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•	 /ntĞrpĞrƐonaů �oŵŵƵnication͗ This is a skill of making effective communication with colleagues and clients 
to create a positive environment in office.  

•	 EĞŐotiation ^kiůůƐ͗ In situations where the decision needs to be made certain negotiations will be needed. 
This is also an important skill that the artist needs to possess for being successful.

ϲ͘ϭ͘ϯ �ĞnĞĮtƐ oĨ ^oŌ ^kiůůƐ

ϲ͘ϭ͘ϰ tork ZĞadinĞƐƐ

Having good soft skills has several benefits. Some of them are 

•	 Good customer satisfaction 

•	 credibility with the clients/ peers goes up

•	 increased productivity 

•	 gets an edge over the competition 

•	 easier to meet the expectation of the client/ peers/ superiors 

•	 increased employment opportunities/ promotion 

•	 self-satisfaction on being able to be good with others 

Having the right attitude at work in crucial for a successful artist. 
The artist should have  

•	 a clear positive attitude in the work place 

•	 the ability to work in a mature environment without support

•	 A good attitude towards the owner

•	 good interest in all the work that is being done 

•	 Expectations of the work that a fresher will be able to do at a 
workplace with financial goals to achieve

•	 The attitude to accept the instructions from a supervisor

•	 the maturity and confidence to ask the right question 

•	 the ability to communicate clearly and crisply with people 

•	 Ability to listen to the customers and provide necessary intervention when needed. 

•	 Be punctual in all the activities that is being done. 

•	 The attitude to learn new techniques of hairdressing/ make up and the attitude to upskills regularly.

Fig.6.1.2: Work Readiness
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ϲ͘Ϯ͘ϭ /ntrodƵction

ϲ͘Ϯ͘Ϯ dŚĞ �oŵŵƵnication ProcĞƐƐ

hE/d ϲ͘Ϯ͗ �īĞctiǀĞ �oŵŵƵnication

By the end of this unit, you should be able to:

1. Speak confidently in public 

2. Talk about likes and dislikes of a person.

3. Know the basic etiquette of conversation.

U n it KbũĞctiǀĞƐ 

Today we are living in an age where communication is an integral part of our lives. We have to communicate send, 
receive and process large number of messages every day. But communication is not just passing information to 
one another. An effective communication is understanding the objective and the emotion behind the information. 
This helps us in various environments like home, work, and in social situations. 

Effective communication is a skill can be improved over time with practice. There is one clear formula for success 
but is effective when it is spontaneous

Communication is nothing but conveying the information through ideas, thoughts, feelings, intentions by writing, 
gestures, speech etc. as long as the information is conveyed. The information exchange should be meaningful . 

A Communication consists of the sender, a message, a medium and the recipient. If a receiver does not 
comprehend the sender’s message it is not effective communication.

Fig.6.2.1: The Communication Process
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Communication involves three basic steps:

1. DĞƐƐaŐĞ͗ This is the information that is available in the senders mind

2. �ncodinŐ͗ The message has to be sent to the receiver in a language/format.

3. �ĞcodinŐ͗ The receiver receives the information and decodes the information to decipher the information 
which makes sense to the receiver.

ϲ͘Ϯ͘ϯ sĞrbaů and EonͲsĞrbaů �oŵŵƵnication
Communication is normally done in 3 types

1. sĞrbaů �oŵŵƵnication͗ As the word indicates “verbal Communication” involves speech and the receiver 
listens to the communication. Feedback in this case is immediate.  

2. triƩĞn �oŵŵƵnication͗ As the term indicates it uses visual medium to communicate using written text and 
language. Letters, new paper, books etc. are examples. They are normally asynchronous in nature. 

3. EonǀĞrbaů �oŵŵƵnication͗ This can also be called Body language because this communication does not 
involve any verbal interaction but mere observation of the people involved in the communication. Both verbal 
and written communications convey nonverbal communication and are also supported by body language, 
eye contact, facial expression, posture, touch and space.

Fig.6.2.2: Categorization and Ratio of Verbal and Non-Verbal Communication
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ϲ͘Ϯ͘ϰ �oŵŵƵnicatinŐ �īĞctiǀĞůǇ /dĞntiĨǇinŐ �arriĞrƐ
There are many reasons why the communication is not effective and these reasons need to be known. There are 
many barriers which make the communication distorted and cause more confusion between the sender and the 
recipient. 

The artist should know these barriers and try to minimize the impact of these barriers by comprehending the 
message regularly and giving correct feedback. The communication needs to be a two way communication. 

Hoǁ to dĞaů ǁitŚ tŚĞƐĞ �arriĞrƐ

•	 Keep the communication simple and use simple words and language commonly understood. 

•	 If the client is speaking in another language and you are aware, be prepared beforehand or ask for help

•	 Keep asking for feedback and give feedback to minimize miss communication. 

•	 Be physically alert to various cues. This could be nonverbal as well. 

•	 Always listen

•	 Ask for feedback even if the client does not give any feedback. 

•	 Share opinions, perceptions

Fig.6.2.3: Barriers in Communication
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ϲ͘Ϯ͘ϱ �īĞctiǀĞ �oŵŵƵnicationͲPracticĞ
�ctiǀĞ >iƐtĞninŐ

Active listening is one of the most important skill to process for a makeup artist or hairdresser. There should be 
no gap in the understanding between what the client/peer/seniors communicates to your understanding.

ϲ͘Ϯ͘ϱ͘ϭ ^oŵĞ dipƐ Ĩor �ctiǀĞ L iƐtĞninŐ 
•	 ^d�P ϭ͗ Concentrate what the person is trying to communicate. Ignore the noise or distractions.

•	 ^d�P Ϯ͗ Understand his emotions and you get it all right. Is the speaker angry, happy or plainly inquisitive?

•	 ^d�P ϯ͗ Do not interfere when the speaker is speaking. It might break the chain of thoughts.

•	 ^d�P ϰ͗ Don’t avoid completing sentences of the speaker. Let them speak and speak only after they finish..

•	 ^d�P ϱ͗ In case you did not understand, ask the speaker to repeat. There is no harm in asking

•	 ^d�P ϲ͗ Practice makes a man perfect. Keep listening and comprehending in various scenarios.
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ϲ͘ϯ͘ϭ PĞrƐonaů 'rooŵinŐ

hE/d ϲ͘ϯ͗ 'rooŵinŐ and HǇŐiĞnĞ

By the end of this unit, you should be able to the following:

1. Maintain cleanliness and hygiene.

2. Keep their dress clean and tidy.

3. Maintain positive body language while speaking.

4. Enable to perform more of the do’s than the don’ts.

5. Understand good eating habits and understand the impact on your health. 

6. Avoiding bad things such as gutkha and alcohol.

7. Learn about AIDS and its prevention.

U n it KbũĞctiǀĞƐ 

As a hair dresser or a makeup artist you will be meeting a lot of 
new people every day. Your first impression with the clients is very 
important. The first impression comes from the way you look and 
carry yourself. Your image is the image of the organization for the 
client. Hence personal grooming is very important in your profession. 
It is about taking care of your appearance and demeanor.

It not only makes you presentable but it also helps you in confidence  
building. In the long run it also helps in your good health.  

There are a few habits that are considered personal grooming. They 
are Dressing, Bathing, Removal of unnecessary hair, oral health, skill 
health, body odor, nails and attire.

�ppĞarancĞ

•	 Your appearance is the first thing that you as an employee impact the organization. As the customer walks 
into your store your appearance will either give a good impression or leave the customer with a bad taste. A 
neat clean and a pleasing experience is what you would want to give to your clients.  

•	 You are expected to be well dressed neat clean and in the company uniform which is well ironed and clean. 
There should not be any visible stain, torn shirt/ trouser etc. Buttons should all be in place and no loose 
thread hanging from any part of the attire. 

•	 Your shoes should always be polished and clean. Avoid Sport shoes with white socks, Sandals, slippers etc. to 
work. It gives an unprofessional look. 

•	 Nails should always be trimmed and clean. 

•	 Hair should be clean and well combed.  Since you are an artist working on the beauty of the client your 
appearance should act as an example to the client. The hair style need not be fancy but should be neat and 
pleasant.

Fig.6.3.1: Personal Grooming
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ϲ͘ϯ͘Ϯ ^pĞciĮc hniĨorŵ 'ƵidĞůinĞƐ

ϲ͘ϯ͘ϯ �odǇ PoƐtƵrĞ

ϲ͘ϯ͘ϰ PoƐitiǀĞ �odǇ >anŐƵaŐĞ

^r͘  Eo͘ ^pĞciĮcaůůǇ Ĩor DĞn ^pĞciĮcaůůǇ Ĩor toŵĞn
1 Uniform prescribed should be clean 

and pressed
Hair should not be oily. It should be well combed and neatly 
tied. No loose hair should be seen. 

2. Shoes should be clean and polished. Avoid long nails and bright nail polish which will impair 
work.

3. Hair must be short, clean & tidy. Minimum, non-flashy jewelry should be worn.
4. One is expected to have a clean shaven 

look
Long earing, noisy bangles should be avoided.

5. IF you beard or mustache it should be 
clean and well-trimmed.

 Make up should be light and pleasing.

6 Neatly cut/ trimmed nails Avoid bracelets, studs to work. 

While meeting someone for the first time always remember that not only you should talk positively but your body 
language also needs to be positive. There are some tips for positive body language as:

Fig.6.3.2: Specific Uniform Guidelines

•	 You need to keep your hands clean. As your hands will be in close contact with customers.

•	 Avoid biting nails on the floor.

•	 No body odor & bad breath should be there. No customer will like it. 

•	 Maintain straight & upright posture on the shop floor.

•	 Slouching on the floor, putting hands in the pockets, keeping your hands on the hips should be avoided.

•	 Avoid sitting with your legs crossed. 

•	 Look confident when you stand next to the customer 

•	 Always keep a smile on your face

•	 For creating a first positive good impression always follow these things:

•	 Be on time

•	 Be yourself and be at ease

•	 Present yourself appropriately

•	 Always smile

•	 Be courteous and attentive

•	 Be positive
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ϲ͘ϯ͘ϱ PĞrƐonaů HǇŐiĞnĞ

•	 Avoid your pockets. Keep your hands out of your pocket. Hand in pocket shows we are uncomfortable and 
unsure of ourselves. Keeping our hand in open indicates confidence and show that people has nothing to 
hide.

•	 Don’t Fidget. Fidgeting is a clear sign of nervousness. An individual who can’t keep still is an individual who is 
worried, tense and not confident. Keep your gesture calm and under control. 

•	 Keep your eyes forward. This indicates that you are interested in communication with other.  

•	 Stand up straight with your shoulders back. It communicates confidence. 

•	 Take wide steps. It makes you seem purposeful and suggest a personal tranquility and denotes confidence.

•	 Firm handshake. Grip other persons hand firmly and confidently instead of getting a palm full of dead fish. 
Firmness adds warmth and enthusiasm to the handshake. But make sure that you don’t crush the other 
person’s hand and don’t hold on too long.

•	 Don’t cross your arms when meeting other persons. This is a protective posture. 

•	 Use contact to show appreciation.

tŚat iƐ PĞrƐonaů HǇŐiĞnĞ͍

Personal Hygiene is the set of practices to follow to preserve one’s health. Maintaining a high level of personal 
hygiene will help to increase self-esteem while minimizing the chances of developing infections. Poor personal 
hygiene can have significant implications on the success of job applications or chances of the promotion. 

Fig.6.3.3: Personal Hygiene
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Why to brush teeth?

………………………………………………………………………………………..

………………………………………………………………………………………..

………………………………………………………………………………………..

Brush your teeth in the morning and before going to bed with 
paste, datun or tooth powder

Why to take bath?

……………………………………………………………………………………………

……………………………………………………………………………………………

……………………………………………………………………………………………

Why to wear clean clothes?

…………………………………………………………………………………………….

……………………………………………………………………………………………

…………………………………………………………………………………………...

Why cut nails?

…………………………………………………………………………………………….

……………………………………………………………………………………………

…………………………………………………………………………………………...

Why wash hands? 

…………………………………………………………………………………………….

……………………………………………………………………………………………

…………………………………………………………………………………………...

Fig.6.3.4: Brush Teeth

Fig.6.3.5: Take Bath

Fig.6.3.6: Clean Clothes

Fig.6.3.7: Cut Nails

Fig.6.3.8: Wash Hands
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ϲ͘ϯ͘ϲ PŚǇƐicaů &itnĞƐƐ
Apart from following these hygienic practices, one should also be 
physically fit. Physical fitness is an outcome of regular exercise. Exercise 
may be of many different forms. Jogging, morning-walk, weight-lifting, 
gym, swimming, cycling, yoga and many more. 

�dǀantaŐĞƐ oĨ PŚǇƐicaů &itnĞƐƐ 

•	 It maintains optimal body weight.

•	 It reduces risk of diseases.

•	 It boosts confidence and self esteem.

•	 It reduces stress, anxiety and depression.

HĞaůtŚǇ �atinŐ

We can follow hygienic practices and exercise regularly, but what we eat has the biggest impact on our health. To 
be healthy, one has to eat healthy. But what do we mean by eating healthy? 

Eating a healthy, balanced diet provides nutrients to our body. These nutrients give us energy; keep our brain 
active and our muscles working.

tŚat arĞ ŚĞaůtŚǇ ĞatinŐ ŚabitƐ͍

•	 Always try to eat home-made food

•	 Avoid oily food

•	 Always cook and eat fresh food

•	 Avoid junk food like burgers, carbonated drinks etc.

•	 Eat fruits regularly

•	 Drink lot of water

dŚinŐƐ to bĞ aǀoidĞd

There are certain habits that have severe ill-effects on one’s health. Such habits should be avoided for a healthy 
life.

Fig.6.3.9: Physical Fitness

Fig.6.3.10: To Eat Fig.6.3.11: Not to Eat
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�ůcoŚoůiƐŵ

Consuming alcohol and getting to work is strictly prohibited. The 
client will never work with any makeup artist or hairdresser who 
has consumed alcohol before work. It will not only impact the 
individuals place in the organization but can also jeopardize the 
organizations reputation as a whole. 

Alcohol also impacts the health of the individual in the long run.  
Alcohol has the potential to interrupt almost every organ in the 
body as well as the brain. Uncontrolled consumption of alcohol 
not only affects a drinker’s health but also human relationship 
and social standings.  

dobacco

The order of tobacco can irritate the client. Since you will be working in close proximity to the client avoid 
smoking during work hours. If you ever have to work with a client after having consumed tobacco/ cigarettes 
then ensure that you have gargeled and washed your mouth. Use a mouth wash to remove the tobacco odder. 

Tobacco is also the second largest cause of death in the world. It claims one death in every six seconds. Smoking is 
a practice of burning a substance and inhaling the smoke coming out of it. Common smoking implements include 
cigarette, bidi, hookas and pipes.

Having tobacco increases the risk of oral or throat cancer.

Fig.6.3.12: Effects of Alcohol

Fig.6.3.13: Risks from Smoking
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/t͛Ɛ ĞīĞctƐ͗ 

•	 It is the biggest reason for oral cancer which effects mouth, tongue, cheek, gums and lips

•	 Chewing tobacco lessens  a person’s sense of taste and ability to smell

•	 Smokers face a greater risk of suffering from lung cancer

'ƵtkŚa

Gutkha is extremely habit-forming and a acknowledged substance. Excessive use of gutkha can cause serious 
health issue. Impact of Gutkha on health:

•	 Loss of sensation in tongue

•	 Disfigured mouth

•	 Increased sensitivity to heat, spices, cold and spices

•	 Inability to open the mouth

•	 Swelling, lumps, rough spots on gums or in other places inside the mouth

•	 Unexplained bleeding in mouth

•	 Difficulty in swallowing and finally Mouth Cancer

ϲ͘ϯ͘ϳ �/�^ͬH/s �ǁarĞnĞƐƐ
Acquired Immunodeficiency Syndrome also known as AIDS is caused by a virus 
called HIV -Human immunodeficiency Virus.   

According to a survey number of AIDS patients in India is between 2 to 3.1 
million almost 50 % of total patients of AIDS. More men are HIV positive than 
women. A total of population of 0.29% females are suffering from AIDS while 
0.43 % males are suffering. 

AIDS is transmitted by:

•	 Unprotected sexual relationships

•	 Contaminated blood transfusion

•	 Hypodermic Needles

•	 From infected mother to child

As per studies in India HIV/AIDS is largely due to unsafe sex worker interactions. Most of the HIV cases is due to 
unprotected sex. Migrant workers, truck drivers and majority of men who have sex with men pose greater risk of 
infecting their spouse and unborn children.  

Fig.6.3.14: Oral Cancer

Fig.6.3.15: NACO Logo
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There are no medicines or vaccines for AIDS so far. The treatment and medicines which are available in the 
market are expensive and have side effects.

AIDS is not a disease like cancer or malaria, but is a condition that weakens a person’s ability to fight diseases 
(immune system). AIDS not only affects you, but also has severe impact on family and friends. Even one mistake 
is enough to get HIV positive.

Fig.6.3.16: AIDS Transmition

Fig.6.3.17: Acute HIV Infection
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^taǇ ĨaitŚĨƵů 

•	 In India large number of people move around for work, 
mostly men.

•	 Are you one of them?

•	 Take care. See that you don’t catch any infection from 
AIDS.

•	 Even one visit to a sex worker may result in HIV infection.

•	 So it is advisable to avoid multiple sex-partners and always 
use protection (condoms/nirodh) during intercourse.

�/�^ doĞƐ EKd ƐprĞad tŚroƵŐŚ

•	 Sitting close

•	 Working together

•	 Hugging

•	 Touching hands

•	 Mosquito bite

•	 Saliva or cough

•	 Taking care

•	 Sharing clothes

•	 Eating together or sharing utensils

ϲ͘ϯ͘ϳ͘ϭ �aƐĞ ^tƵdǇ
Gautam is a plumber. His family lives in a village. He travels from place to place. Once he visited a sex worker. After 
one month he fell ill. He went for a checkup and found he had AIDS. Gautam did not know it, but that sex worker 
had AIDS. He was infected from that one visit.

Fig.6.3.18: AIDS Non-nispersing Deseases

Fig.6.3.19: Condoms
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Share four things that you know or learnt about AIDS.  

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

�ůǁaǇƐ rĞŵĞŵbĞr͗ 

•	 AIDS has no cure but can be prevented, therefore be cautious of it not afraid of it.

•	 Be faithful to your partner and always use condom while making any sexual contact.

•	 Take blood only after checking proper medical certificates.

•	 Do not discriminate HIV positive people.
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ϲ͘ϰ͘ϭ /ntrodƵction

ϲ͘ϰ͘Ϯ PoƐitiǀĞ �ƫtƵdĞ

hE/d ϲ͘ϰ͗ /ntĞrpĞrƐonaů ^kiůů �ĞǀĞůopŵĞnt

By the end of this unit, you will:

1. Work towards a positive attitude and behavior.

2. Understanding Goal Setting.

3. Motivated for team participation at work.

4. Learn how to manage relations.

5. Learn about Stress and anger management skills.

6. Learn to develop leadership qualities.

U n it KbũĞctiǀĞƐ 

Interpersonal skill development is the blend of different traits of day to day life that play an important role in 
creating our impression in other’s mind. It starts from inside. The role of interpersonal skill development is to 
help us understand how to make choices about our attitudes and actions. It enables us to understand:

•	 Where are we now?

•	 How change and growth occur successfully?

•	 How we can change our attitude to get results we want and to be more effective in work and personal life?

One can learn to control over many aspects of our job and their environment by making appropriate choices and 
responses.

These include various traits like:

•	 Positive Attitude

•	 Motivation

•	 Goal Setting

•	 Team Work

•	 Managing Relations

•	 Etiquette

•	 Stress and Anger Management

•	 Conflict Resolution

tŚat iƐ aƫtƵdĞ͍       

•	 Our approach...

•	 Our outlook towards situations and others…



108

Participant Handbook

•   The emotions we express towards others.

•   Our attitude must be positive and hopeful.

ZĞŵĞŵbĞr͗

•	 Luck favors those who help themselves

•	 Make things happen and don’t wait for it to happen 

•	 Stay away from negative influences

•	 Start your day with something positive

•	 If it needs to be done, learn to like it. 

Positive attitude shows in the following ways:

•	 Positive thinking

•	 Constructive things

•	 Creative thinking

•	 Optimism

•	 The motivation and energy to accomplish goals.

•	 An approach of happiness

Positive thinking results in satisfaction and success.  

ϲ͘ϰ͘Ϯ͘ϭ ^torǇ oĨ �arrot͕ �ŐŐ and �oīĞĞ �ĞanƐ
Raju works as a Supervisor in a factory. He is not happy with 
his job. One day he spoke about his dejection to his elderly 
friend, Prashant, who runs a small canteen for the factory 
workers.

“Prashant I am not satisfied with my job. There are so many 
problems in the factory. If I solve one, another one crops up. 
The problems seem to be never ending. I am quite fed up 
and wish to quit.”

Prashant said nothing. He quietly put three pots with water 
on the stove. He put some carrots into one pot, some eggs 
into another and coffee beans into the third pot. The water 
in the pots began to boil. 

Raju wondered what was going on! “Oh, here I am with my 
tale of woes, and this illiterate cook goes about his business!”

After some time, Prashant switched off the stove and put 
the carrots, eggs and the beans in different bowls. He then 
said, “My friend, what do you see here?” “Carrots, eggs and 
coffee”, said Raju irritably. “Of course! Now come and feel them one by one”, said Prashant. “Oh God! What do you 
want to prove?” asked Raju controlling his anger. “The carrots have turned soft. The egg is hard boiled beneath its 
shell and the coffee is stronger in aroma”. “Exactly” said Prashant “Each of them faced the same degree of heat, but 

Fig.6.4.1: Positive Attitude

Fig.6.4.2: Story of Carrot, Egg and Coffee Beans
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ϲ͘ϰ͘Ϯ͘Ϯ ^oŵĞ ^ƵccĞƐƐĨƵů PĞopůĞ

each reacted differently. The carrots that were so hard before became soft and weak. The egg was fragile with 
its thin outer shell, but after boiling it became hardened and the inner liquid portion became hard boiled. But the 
coffee beans are unique. After boiling in water, they became stronger and richer. So my friend, tell me, are you 
the carrot, the egg or the coffee  bean? How do you respond to difficult situations? Are you like the carrot that is 
hard to look at but with the slightest difficulty becomes weak and soft? Are you the egg born with a soft heart but 
became tough and stiff after a difficult or a bitter experience? Or are you like the coffee bean that gets stronger 
and tougher and reaches its peak in extreme adversity or difficulty? 

When things get worse, you get better.   

“Thank you Prashant. You’ve opened my eyes. I shall strive and do my best.”

tŚat ŚaǀĞ ǇoƵ ůĞarnt Ĩroŵ tŚĞ ƐtorǇ͍

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Dirubhai Ambani - Founder of the Reliance brand

Born in Junagadh in a middle class family, son of a school 
teacher. His mother who had difficulty meeting the ends with 
his father’s income, nagged him to begin earning some money. 
He snapped at her “Phadia, phadia su karo chho …paisa no to 
dhanglo karees …” Just to show that that he was serious, he 
once bought a tin of groundnut oil on credit from a local whole 
seller and sold the oil in retail sitting on the roadside, earning a 
profit of a few rupees that he gave to his mother. 

Next, he began setting up onion and potato fries stalls at village fairs during weekends when his school was closed. 
When he grew up, he came to Mumbai with very little money and lived in a two room chawl with his family. But 
dreamt big and worked towards his dreams.

Rajnikanth: Super star of Tamil cinema

•	 Hero and demi-God for many thousands

•	 Original name Shivaji Rao Gaekwad

•	 From bus conductor to super star 

Early life:

•	 Driven by poverty, went through extreme struggle

•	 No education; Worked as a bus conductor

•	 Entertained passengers in the bus

•	 Got a break in Tamil cinema

•	 Worked with a single mind to become a super hero

Fig.6.4.3: Dirubhai Ambani - Founder of Reliance

Fig.6.4.4: Rajnikanth: Super Star of Tamil Cinema
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tŚat ŚaǀĞ ǇoƵ ůĞarnt Ĩroŵ tŚĞƐĞ tǁo pĞopůĞ͍

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

ϲ͘ϰ͘ϯ 'oaů ^ĞƫnŐ
Goal setting is to visualize your ideal future and realizing what and where you want to be. The method of setting 
goals helps you in being clear on where you want to be and what you want to do in life.

This consists of establishment of specific, measurable, achievable, realistic and time targeted aim. Goal setting 
helps individuals to be clear on their own objectives in life and work towards it. They help motivate you to move 
forward in life and to achieve what you want to achieve. To set up the goal set SMART goals:

•	 S stands for: Specific

•	 M stands for: Measurable

•	 A stands for: Attainment

•	 R stands for: Relevant

•	 T stands for: Time bound

/dĞntiĨǇ

•	 What you want to achieve,

•	 Where you have to concentrate your efforts

•	 Also spot the distractions that can, lead you astray.

&irƐt crĞatĞ ǇoƵr ͞biŐ pictƵrĞ͟ ;tŚĞ nĞǆt ϭϬ ǇĞarƐ Ĩroŵ noǁͿ

•	 Identify the long term goals that you just wish to achieve.

•	 get smaller targets in place which needs to be met to achieve the long term target 

•	 Once the plan is in place you work on the plan to achieve the long term goal 

^ĞƫnŐ Őoaů iƐ iŵportant Ĩor an indiǀidƵaů bĞcaƵƐĞ͗

•	 Goals narrow attention and direct efforts to goal related activities.

•	 Goals lead to more effort.

•	 One works through setbacks if he is pursuing a goal.

•	 It develops and changes individuals behaviour.

�atĞŐoriǌation oĨ 'oaůƐ

It is important to categorize the different kinds of Goals 

•	 �arĞĞr͗  In your professional career where you want to reach and what do you want to do?

•	 &inanciaů͗  How much you want to earn, by what stage? Is it related to your career goals?

•	 �dƵcation͗ To achieve the long term goal what skills and education do you need over time? 

Fig.6.4.5: Goal Setting
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•	 &aŵiůǇ͗ How you want to be seen by your spouse and family members? 

•	 HĞaůtŚ͗ Do you want to stay healthy in old age? How are you planning to achieve this? 

•	 PƵbůic ^ĞrǀicĞ͗ Do you want to have social goals? What are those? 

Write down your two financil goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Write down your two career goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Write down your two educational goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Write down your family related two goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Write down your health related two goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

Fig.6.4.6: Categorization of Goals
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ϲ͘ϰ͘ϰ dĞaŵ �ǇnaŵicƐ

Write down your public service related two goals.

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

When a group of people come together with a common goal they are called a team.  This creates a dynamic 
bond amongst the team members because they are help on one another for the success of the team. Examples 
of team are sports team (cricket), dance team etc. the team as a whole win or lose.

�Ɛ a tĞaŵ ŵĞŵbĞrƐ nĞĞd to ůĞarn͗

•	 How to work with one another. 

•	 Understand each other’s strengths 

•	 Prepare the atmosphere that is familiar with each member to work beyond their strength.

&actorƐ oĨ dĞaŵ �ǇnaŵicƐ

•	 Tolerance and Cooperation

•	 Set aside feelings of caste, creed, profession

•	 Put up with each other

•	 Identify strengths of each

•	 Who can do what

In a team, there is no room for personal gains and definitely not betrayals. In a team: 

•	 A single person cannot achieve a big task single handedly.

•	 Big and difficult tasks can be accomplished only through collective effort, through teams.

•	 In a team, the team members stand by each other during good and bad times alike.

•	 Work together towards a common goal.

•	 Tasks are divided and the burden shared

•	 Help each other and ask for help from others. 

Fig.6.4.7: A Teamwork
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ϲ͘ϰ͘ϰ͘ϭ ^torǇ͗ ^ŵaůů &iƐŚĞƐ and �iŐ &iƐŚ

ϲ͘ϰ͘ϱ DanaŐinŐ ZĞůationƐ

Once there was a shoal of tiny red fish living in the sea. One 
among them was a little different. His name was Swimmy and 
he was black in colour. Swimmy was the fastest swimmer in the 
shoal. The fish would swim around in the sea looking for food. 
One day when they were busy searching for lunch, Swimmy 
who was far ahead of the others saw a big fish coming in their 
direction. The big fish was also looking for his lunch---smaller 
fish. Swimmy was scared! If the big fish would spot his shoal, all 
of them would be eaten up. Swimmy thought hard of a way out 
and quickly came up with a plan. He quickly swam back to his 
shoal and told all the fish about the big fish and also explained 
his plan to escape from being eaten.

When the big fish came closer he was shocked to see an even 
bigger fish swimming in his direction with its huge jaws wide 
open. Frightened that he would get eaten up, the big fish swam 
away. If he had looked carefully, he would have realized that 
the huge fish was actually all the tiny red fish swimming very 
closely together in such a way that they looked like one big fish. 
And little black Swimmy, being different, became the eye of the 
‘huge’ fish!

What have you learnt from the story?

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

……………………………………………………………………………………………………………………………………………………………………………

All of us have different desires, different personalities, likings, and different 
means of showing our feelings that affects people around us.

70% of the workplace learning is informal, once people discuss with each other 
at work they really are learning to do their job better. Friendlier staff are good 
communicators and more productive. They are also trusted more by employers 
and colleagues.

Tips for improving relations with people around us: 

•	 Observe how you react to people such as do you reach to a conclusion

Fig.6.4.8(a): Small Fishes and Big Fish

Fig.6.4.8(b): Small Fishes and Big Fish

Fig.6.4.9: Managing Relations
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•	 Before you know all the facts.

•	 be true to yourself on how you interact with others

•	 Look at work environment. Do you seek attention for accomplishments or give chance to others.

•	 Accept your weaknesses courageously and work on them.

•	 Make sure you are responsible for your own actions. 

•	 If you think you hurt someone, apologize.

ϲ͘ϰ͘ϲ �tiƋƵĞƩĞ
Etiquette are nothing but rules operating behavior regarded as good and acceptable in personal and professional 
life. Etiquette includes:

DakinŐ PoƐitiǀĞ /ŵprĞƐƐion

•	 Stand straight, make eye contact 

•	 Turn towards the person who you are communicating with. Genuinely smile at people.

•	 Use ow the dress code prescribed by the organization.

•	 When meeting someone for the first time always shake hands with a gentle firmness.

•	 Always arrive early to work each day.

Hoǁ ǇoƵ trĞat ǁitŚ pĞopůĞ

•	 Think how you treat your supervisors and colleagues.

•	 Don’t make value judgments on people’s importance at workplace. Respect every individual equally.

•	 Respect people’s personal space at workplace.

�oŵŵƵnicatinŐ at torkƐpacĞ

•	 Keep workspace professional and neat.

•	 Don’t interrupt other people on the workplace.

•	 Limit personal calls especially when you are working in a manufacturing unit.

•	 Eat and smoke to the designated areas only otherwise it may disturb other people.

tork �tŚicƐ

Believes and morals at work constitutes Work ethics. Work ethics include:

•	 �iƐcipůinĞ͗ Only with discipline one can stay fixed on goals and determined to complete his assignment. 

•	 �oŵŵitŵĞnt to ǁork͗ A strong sense of commitment to work affects how an individual work. The quality 
and the amount of work he does depends on the commitment. Committed worker turns up on time, puts in 
his best efforts and completes the projects to the best of his ability. 

•	 PƵnctƵaůitǇ͗ a committed and responsible working comes to work on time and finishes the given task on 
time. Being punctual gives a sense of professionalism. 

•	 KǁnĞrƐŚip and rĞƐponƐibiůitǇ͗ Ownership and responsibility stretches in all aspects of an employee’s job. 
Supervisors rely on the high moral standards trusting him not create problems and being responsible. 
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ϲ͘ϰ͘ϳ ^trĞƐƐ and �nŐĞr DanaŐĞŵĞnt

ϲ͘ϰ͘ϴ �onŇict ZĞƐoůƵtion

•	 ^triǀinŐ to ĞǆcĞů͗ Keep yourself updated with new developments and knowledge of your field. Learn new 
skills, techniques, methods required to uplift your career..

Anger is a normal and a healthy emotion. Anger management 
however is critical for people who cannot manage their anger. 
There are many health issues related to an unresolved anger like 
heart attack, high blood pressure, anxiety, depression, colds and 
flu/fever and digestive problems.

If your heart beats faster and you breathe quickly, tension in 
your shoulder or clinching your fists beware your body may be 
showing sign of anger, take steps to calm yourself down. Once 
you will be able to recognize the signs of anger you can calm 
yourself down.

ZĞŵĞŵbĞr tŚĞ ĨoůůoǁinŐ͗

•	 Avoid unnecessary stress, learn to say no  

•	 Keep expressing your feelings. Don’t let it bottle up 

•	 Accept the things you can’t change.

•	 Learn to forgive.

•	 Anger can destroy lives, destroy relationships.

•	 Put yourself in other’s shoes.

•	 Don’t react immediately.

•	 Post pone for a few seconds whatever you wish to say or do.

•	 Take a deep breath.

•	 Speak when you have calmed down.

tŚat iƐ a �onŇict͍

A difficult situation which is difficult to understand and deal with is a conflict. 

Fig.6.4.10: Stress Management

Fig.6.4.11: Anger Management
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tŚǇ do ǁĞ nĞĞd to rĞƐoůǀĞ conŇictƐ͍

•	 The conflict may blow out of proportion if not addressed in time 

•	 An unsolved problem can spread and translates itself into all other areas of life

•	 If problems are not resolved they will lead to further frustration 

•	 It leads to bitterness between individuals 

•	 If the conflict is not resolved it may lead to personal issues between two individuals. 

Hoǁ to ǁork oƵt �onŇictƐ͍

1. End it there . . .

        Try and stop the conflict the moment you realize there is one. Nip it at the bud. 

2.     Communicate

        Talk about the issue, why there is a disagreement and how you think it can be resolved. 

3.     Listen to others

        Get the point of view of other people involved in the conflict and try and rework on the resolution. 

4.     Think of solutions 

        The solution should satisfy all parties involved or there should be a consensus. 

If there is no resolution possible get a neutral person in for discussion and resolution. 

If you still can't agree, ask someone else to help you work it out.

ϲ͘ϰ͘ϵ >ĞadĞrƐŚip ^kiůůƐ
Leadership skills are one of the key skills that most employers look for in an employee. A person should be able to 
lead his/her team and should guide the team towards the common objective of the team. Some of the qualities 
that every good leader should possess are:

•	 HonĞƐtǇ͗ If you are honest its most likely that the team members will also be honest 

•	 �īĞctiǀĞ dĞůĞŐation͗ One person cannot do everything. It’s important to understand the strength of every 
member in the team and delegate work prudently. Effective delegation help in increase of efficiency 

•	 'ood coŵŵƵnicationƐ ƐkiůůƐ͗ Being able to communicate clearly is quite important. 

•	 �onĮdĞncĞ͗ Keeps morale of the team high even in the tough times.

•	 �oŵŵitŵĞnt͗ If you want your team to deliver and be committed to the tasks. You have to be committed 
first. 

•	 PoƐitiǀĞ �ƫtƵdĞ͗ Keeping teams motivated towards continued success of the company. 

•	 �rĞatiǀitǇ͗ During the critical situations it is important to think out of the box solutions than to prefer the set 
course of action. 

•	 �iciǀĞnĞƐƐ͗ Nothing is certain and things can go wrong anytime. Plan for the worst and most things will be 
under control. Taking a firm decision (which is correct) is a crucial to give confidence to your team.   

•	 &ocƵƐ on tŚĞ biŐ pictƵrĞ͗ always look at the big picture. Sometimes you might have to deliberately ignore a 
few things which do not impact anything at work as long as the team is working towards the bigger picture. 
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Hoǁ to bĞcoŵĞ a ůĞadĞr͗

•	 Take initiatives to act on various opportunities that you get. 

•	 Set you priorities right and work towards the bigger goal. Make it clear that you are working towards it

•	 Try and resolve issues. Do not pass it on

•	 Work beyond what is expected from you. Promise less deliver more. 

•	 Bring in energy to the team

•	 Forecast potential issues in the future, take necessary steps and actions to resolve the issues.

•	 Suggest changes to increase efficiency, customer satisfaction etc. 

•	 Keep enhancing your skills and be the best at what you are doing. Be the best hairdresser or a makeup artist 
in your store and set examples.
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ϲ͘ϱ͘ϭ ^ociaů /ntĞraction

ϲ͘ϱ͘Ϯ ^ĞůĨͲ/ntrodƵction

hE/d ϲ͘ϱ͗ ^ociaů /ntĞraction

At the end of this unit, you will be able to:

1. Understand what social interaction is and what social interaction behavior are.

2. Give a brief description about himself/herself in public.

3. Follow daily duties.

4. Cooperate with peers, family and other members in society.

U n it KbũĞctiǀĞƐ 

Social interaction is a process through which we respond to people 
talking with us. It includes acts where people perform toward each other 
and responses they give in return. Social interaction has a number of 
behaviours. Some of them are:

•	 �ǆcŚanŐĞ͗ Exchange is the most elementary kind of social interaction. 
It’s a human process by that social behavior is exchanged for some 
kind of reward for equal or greater value.

•	 �oŵpĞtition͗ It’s a process by which two or more individuals plan to 
accomplish a goal that just one can attain. It will lead to psychological 
stress, a lack of cooperation in social relationship, difference and even conflict.

•	 �oopĞration͗ It’s a process in which people work together to achieve shared goals. Task cannot be completed 
without their cooperation. 

•	 �onŇict͗ Social conflict is the struggle for agency or power among a society to achieve control of scarce 
resources. It happens when two or more individuals oppose each other in social interaction to achieve 
incompatible goals. 

•	 C oe rc ion :  People or teams are forced to provide in to the desire of other people or teams.

We all, in our lifetime, have to introduce ourselves to the others. The 
introduction usually lasts for around 2 minutes to 3 minutes. It is very 
important that it gives the first impression to other about us. It has a great 
impact on your self-esteem and self-confidence. It’s helpful in:

•	 Feeling better about yourself

•	 Boosting your confidence

•	 Building your self esteem

•	 Making friends

•	 Feeling in control

Fig.6.5.1: Social Interaction

Fig.6.5.2: Self-Introduction
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PointƐ Ĩor ^ĞůĨ /ntrodƵction

Following are some self-introduction points:

•	 tiƐŚĞƐ͗ It is the first thing that we need to do before addressing a gathering. At this point we need to make 
effort to grab the attention of audience. You have to wish depending on the time either, Good Morning, Good 
Afternoon or Good Evening.

 » Good Morning! My dear friends.

 » Respected Sir! Good morning.

 » Special or lovely or cool morning to you all.

•	 PƵrpoƐĞ͗  We have to tell the purpose of coming in front of the audience. We can say I have come here to tell 
you about myself.

•	 EaŵĞ͗ Here you tell about your name….. . To grab the eye of the audience, you have got to present your 
name differently. If you know you can tell the meaning of your name or nay famous celebrity along with your 
name.

•	 &atŚĞr͛Ɛ EaŵĞ͗ Here you have to say concerning your father’s name. begin your father name as Mr. or Prof. 
or Dr.

•	 &aŵiůǇ͗ It’s a good chance to inform about your family, therefore tell the small print what you want to tell 
about them. 

•	 ProĨĞƐƐion͗ Tell about your profession what you're doing at the moment.

•	 >ocation͗ Tell about your present location, wherever you're staying and if you would like you can also tell with 
whom you're living.

You can also tell about your native place. It is better to describe about or tell about your place which is famous for.

•	 HobbiĞƐͬHabitƐ͗ Hobbies means what you like in your leisure and habit means your regular activities. This 
part tells about your nature and your life style, be careful while telling this.

•	 >iĨĞ �iŵ͗ Tell about what is your aim in life, it will be good if your aim is high. You have to think high and reach 
high.

•	 �cŚiĞǀĞŵĞntƐ͗ Tell about what you achieve up to now, minimum it is good to tell about three achievements 
and maximum five. Though achievements are small, tell them it shows your confidence but don’t say I don’t 
have any achievements.

•	 &aǀoƵritĞ PĞrƐon͛Ɛ or /dĞaů͗ It is good to say about your ideal persons. 

•	 &aǀoƵritĞ ŵoǀiĞƐ͕ tŚinŐƐ͕ coůoƵr͕  půacĞƐ Ğtc͗͘ if you want to tell your favorites, which tell about your tastes 
and preferences to others.

•	 zoƵr ^trĞnŐtŚƐ and tĞaknĞƐƐ͗ You can tell about your strengths and weaknesses. Make sure your weakness 
should not be absurd or incorrigible. 

•	 PĞopůĞ ǇoƵ ůikĞ and diƐůikĞ: You have to tell what kind people you like or what kind of people you dislike. 

•	 Any turning point in your life

•	 How are you different from others

•	 �oncůƵƐion͗ In conclusion offer a memorable answer on the question the listeners probably will have when 
they have listen to your public speaking speech. Tell how this aspect of your life makes you what you are and 
who you are. It will be perfect ending to your self –introduction. 

•	 Finally say thank you.
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You will have to maintain your speech according to the time, generally 3 minutes and you have to make the 
speech depending on the section of people you are giving the speech and what you want to reveal about yourself. 

/ŵproǀinŐ ƐĞůĨͲintrodƵction

There are a few things that you can do that helps in making your self-introduction better:

•	 >iƐtĞn to ǁŚat ǇoƵ arĞ ƐaǇinŐ to ǇoƵrƐĞůĨ͗ Notice what your inner voice is saying. Take some time to listen 
and even write down what you are thinking. 

•	 Donitor ǇoƵr ƐĞůĨͲtaůk͗ Analyze that your self-talk is more positive than negative. 

•	 �ŚanŐĞ ǇoƵr introdƵction͗ counter your negative thoughts with positive ones. Avoid speaking negative and 
try to look for things that might add a better spin to a tough situation.

ϲ͘ϱ͘ϯ KƵr �ƵtiĞƐ and ZĞƐponƐibiůitiĞƐ

ϲ͘ϱ͘ϰ �oopĞration

There are certain duties which are laid by the Constitution of India. These duties are very to be fulfilled by every 
citizen of India. These are as follows:

•	 To bear by the Constitution and respect its ideals and establishments, the national flag and also the national 
anthem.

•	 To encourage and respect the noble ideals that galvanized our national struggle for freedom.

•	 To uphold and protect the sovereignty, unity and integrity of Republic of India.

•	 To defend the country and render national service once called upon to do so.

•	 To promote harmony and also the spirit of respect amongst all the people of the Republic of India transcending 
religious, linguistic and regional diversities.

•	 To forbid practices derogative to the dignity of ladies.

•	 To preserve the rich and diversified heritage of our culture.

•	 To conserve the natural surroundings like forests, lakes, rivers and wild life, and to have compassion for living 
creatures.

•	 To develop the scientific temper, humanism and the spirit of inquiry and reform.

•	 To safeguard public property and to retract violence.

•	 To try towards excellence altogether spheres of individual and collective activity so that the nation perpetually 
rises to higher levels of endeavor and accomplishment.

These need to be followed by every citizen of India for development of the country.

The process of groups of organisms working or acting together for their 
mutual benefit is called cooperation. Cooperation among family members, 
friends and peers is very common and healthy. It is the backbone of any 
society.

Family cooperation provides an avenue for a family to come closer. It 
increases coping skills and decision making. Some steps to promote family 
cooperation are:

Fig.6.5.3: Cooperation
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•	 Půan tŚinŐƐ toŐĞtŚĞr͗ It calls for negotiation and compromise and teaches everyone to be more tolerant and 
considerable to other’s viewpoint.

•	 ^ŚarĞ rĞƐponƐibiůitiĞƐ͗ Diving up necessaryhousehold responsibilities can be a good exercise in family 
cooperation. 

Peer support occurs once individuals give knowledge, experience, and emotional, social or sensible help to each 
other. It’s a distinct state of social support in this the source of support may be a peer an individual who is 
analogous in ways to the recipient of the support.

The effective peer support can be in form of:

•	 ^ociaů ^Ƶpport͗ In form of positive psychological interactions with others with whom there is mutual trust 
and concern. 

•	 �ǆpĞriĞntiaů <noǁůĞdŐĞ͗ contributes to solve problems and improve quality of life.  

•	 �ŵotionaů ƐƵpport ͗ Esteem, attachment and reassurance

•	 /nƐtrƵŵĞntaů ^Ƶpport͗ Product and services.

How to be a cooperative person:For being a cooperative person following things needs to be done:

•	 Listen carefully to others and make sure you perceive what they're expressing.

•	 Share when you have something that others would really like to have.

•	 Take Turns once there's something that no-one desires to do, or when more than one person desires to do a 
similar factor.

•	 Compromise when you have a significant conflict.

•	 Do your part the very best that you just probably can. This can inspire others to do the same.

•	 Show appreciation to people for what they contribute.

•	 Encourage people to do their best.

•	 Make people needed. Working together may be a lot more fun that manner.

•	 Don’t isolate or exclude anyone. Everyone has something valuable to offer, and nobody likes being omitted
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ϲ͘ϲ͘ϭ 'roƵp /ntĞraction

hE/d ϲ͘ϲ͗ 'roƵp /ntĞraction

At the end of this unit, you will be able to:

1. Participate in group discussions in the class.

2. Give speech in the public.

3. Understand the importance of team building and team work.

U n it KbũĞctiǀĞƐ 

Every day we tend to meet with teams of individuals socially 
and professionally. However we interact to play a big role in the 
impressions we tend to produce. Interaction that happens whereas a 
group completes a cooperative task describes how the group works. 
For a successful and positive group interaction these steps needs to 
be followed:

•	 Put your mobile phone away or place in silent mode.

•	 Greet everyone.

•	 Be friendly with everyone in the group

•	 Show an interest in others by paying someone a compliment and listen carefully to what is being discussed.

•	 Be proactive and introduce yourself to others in the group.

•	 Sit up straight. Poor body posture is an indication of low self-esteem.

•	 Focus your attention on the person talking.

•	 Don’t discount anyone’s comment. Remember everyone is different and have different the ability to think.

•	 Think before you speak. Don’t be too quick to jump into the conversation.

•	 Be a respect listener and observer.

•	 Include everyone when talking. Be sure to share eye contact with each person in the group.

•	 Unless there is a clear indication don’t change the topic. Otherwise it will make people feel you are not 
interested in the topic.

•	 Don’t start or participate in a side conversation. Don’t allow their mistake to prevent you from being a good 
listener.

•	 Make sure to smile shake hands and embrace and use each person’s name when conversation and the 
person’s name when the discussion is over.

Everything you are doing in a group setting makes an effect on everybody in the group. Don’t ever suppose 
something doesn’t matter. Everything matters. Take every chance to take part in informal and formal group 
interactions. Begin by creating small contributions to discussion, prepare an issue to raise or accept as true with 
another person’s remark. Ask for other persons opinion.

Fig.6.6.1: Group Interaction
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ϲ͘ϲ͘Ϯ /ŵportancĞ oĨ 'roƵp /ntĞractionƐ

ϲ͘ϲ͘ϯ dĞaŵ tork

As a participant group interactions is important as:

•	 As a participant group interactions is important as:

•	 It helps you to get a subject more deeply.

•	 It improves your strength to think positively.

•	 It helps in solving a serious issue.

•	 It helps the team to go on a final decision.

•	 It provides you the chance to listen to others' ideas.

•	 It improves your listening skills.

•	 It increases your confidence in communications.

•	 It can change your behavior.

•	 Understanding a member interpersonal skills.

•	 Identifying if a member is able to work in a team.

•	 Understanding ones behavior.

•	 Selecting a perspective member in a perspective methodology.

�oƐ and �on͛tƐ oĨ 'roƵp /ntĞraction

�o͛Ɛ D on ' t
•	 Speak pleasantly and in a well mannered way to 

the group. 

•	 Respect the contribution of each speaker. 

•	 Remember that a discussion isn't AN argument. 
Learn to disagree in a well mannered way. 

•	 Think about your contribution before you speak. 
How best can you answer the question/ contribute 
to the topic? 

•	 Try to follow the discussion topic. do not introduce 
tangential information. 

•	 Be aware of your visual communication when you 
are speaking. 

•	 Agree with and acknowledge what you find 
fascinating.

•	 Lose your temper. A discussion isn't an argument. 

•	 Shout. Use a moderate tone and medium pitch. 

•	 Use too several gestures when you speak. Gestures 
like finger pointing and table thumping will appear 
aggressive. 

•	 Dominate the discussion. Confident speakers 
ought to enable quieter students an opportunity 
to contribute. 

•	 Draw too much on personal experience or 
anecdote. Although some tutors encourage 
students to reflect on their own expertise, keep in 
mind to not generalize an excessive amount of. 

•	 Interrupt. Wait for a speaker to complete before 
you speak.

Fig.6.6.2: Dos and Don’ts of Group Interaction

Team work is a critical part of professional life.  They can have a big impact on: 

•	 The profitability of an organisation.
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•	 People enjoy their work.

•	 Staff retention rates.

•	 Team and individual performance.

•	 Company reputation.

/ŵportancĞ oĨ dĞaŵ �ƵiůdinŐ

Team building activities not only boost morale of the team 
members, but it can also increase the success rate of the 
teams. Team building is an important activity as it: 

•	 &aciůitatĞƐ bĞƩĞr coŵŵƵnication͗ Activities that create 
discussion results in open communication among the employees, and among employees and management. 
This improves office environment also the quality of work.

•	 DotiǀatĞƐ ĞŵpůoǇĞĞƐ͗ The more comfortable team members are to share their ideas and opinions, the more 
confident they will be. This motivates them to take on new projects or challenges.

•	 ProŵotĞƐ crĞatiǀitǇ͗ Working closely with other team members increase creativity and promotes new ideas.

•	 �ĞǀĞůopƐ probůĞŵͲƐoůǀinŐ ƐkiůůƐ͗ Team building activities that require team members to work closely to solve 
problems improves the ability to think rationally and logically. Teams that determine when a problem arises 
and knows the solution can work better when a real problem occurs.

•	 �rĞakƐ tŚĞ barriĞr͗ Team building increases trust among workers.

�oΖƐ and �on͛tƐ oĨ ǁorkinŐ in a dĞaŵ

•	 �on͛t arŐƵĞ in pƵbůic͗ if you have a disagreement with someone in the team find a neutral place to discuss 
the situation.

•	 �o ĞncoƵraŐĞ ĞacŚ otŚĞr͗ when things get tough the tough gets going. Contribute to the team in trying 
situation.

•	 �on͛t taůk bĞŚind tŚĞ backƐ͗ if you have trouble with some team member don’t share with others. Go directly 
to the person in a kind and compassionate manner and share what is in your mind.

•	 �o ůĞnd a Śand͗ if a team members is asking for help don’t hesitate in helping him.

•	 �on͛t bĞ tŚĞ ǁĞakĞƐt ůink͗ Live up to your responsibilities, meet team expectations and communicate 
effectively in the team.

•	 'iǀĞ and rĞcĞiǀĞ ĨĞĞdback͗ As a part of growing team give and receive feedback respectfully and graciously.

Fig.6.6.3: Team work
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ϲ͘ϳ͘ϭ diŵĞ DanaŐĞŵĞnt

ϲ͘ϳ͘Ϯ diŵĞ ZobbĞrƐ

hE/d ϲ͘ϳ͗ diŵĞ DanaŐĞŵĞnt

At the end of this unit, you will be able to:

1. Understand the importance of time management.

2. Develop time management skills.

3. Learn about effective time planning.

U n it KbũĞctiǀĞƐ 

Time management is the process of planning and practicing 
control over the time given to a specific task, especially to increase 
effectiveness, efficiency and productivity. It is an activity with the 
goal to increase the overall advantage of a set of activities within the 
limited condition of a limited time.

^oŵĞ ĞīĞctiǀĞ tiŵĞ ŵanaŐĞŵĞnt

•	 Delegate tasks.

•	 Identify time wasters.

•	 Combine activities – Plan for them.

•	 Break down big tasks down to the smallest task possible.

•	 Accomplish them one by one.

•	 At the end of the day conduct a simple analysis to see which activity took time.

Time robbers are those activities which create interruption at the workplace. These activities create a deviation 
from the objectives which needs to be achieved. Time Robbers could be:

•	 Poor personal planning and scheduling.

•	 Interruptions by people without appointments.

•	 Poor delegation.

•	 Poor use of the media: Telephone, Mobile, e-mail, and fax, etc.

•	 Reading junk mail.

•	 Lack of concern for god time management.

•	 Lack of clear priorities

Fig.6.7.1: Time Management
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The Time Robbers can be avoided by:

•	 Be active all the time.

•	 Develop and maintain an organized personal activity schedule.

•	 Set your priorities.

•	 Proper delegation.

•	 Utilize modern technical media.

ϲ͘ϳ͘ϯ ParĞto �naůǇƐiƐ
•	 According to this 80% of the tasks can be completed in 20% of the time. The remaining 20 % of the tasks take 

80 % of your time. And the task which should fall in first category should be given a higher priority.

•	 Time also depends on the type of method adopted to process the task. Methods should always be simpler 
and easier to complete the task. If we use difficult ways, it shall be result the waste of time. One should 
always try to find out alternate ways to complete a task.

hrŐĞnt /ŵportant Datriǆ

ϭ͘ dŚĞ hrŐĞnt and /ŵportant daƐkƐ Ϯ͘ dŚĞ Eon hrŐĞnt bƵt /ŵportant daƐkƐ
DO NOW

•	 Emergencies, complaints and crisis issues

•	 Superiors desire

•	 Planned tasks or project work now due

•	 Meetings with superiors/colleagues

PLAN TO DO THEM

•	 Planning, preparation

•	 Scheduling

•	 Designing, testing

•	 Thinking, creating, modeling the data
ϯ͘ dŚĞ Eon /ŵportant bƵt hrŐĞnt daƐkƐ ϰ͘ dŚĞ Eon /ŵportant and nonͲhrŐĞnt daƐkƐ

REJECT AND EXPLAIN

•	 Small requests from others

•	 Ostensible emergencies

•	 Misunderstandings rising in work

•	 Pointless routines or activities

RESIST AND CEASE

•	 Comfort’ activities, computer

•	 Games, net surfing, excessive

•	 Cigarette breaks

•	 Chat, gossip, social

•	 Communications

•	 Reading irrelevant and useless material
Fig.6.7.2: Urgent Important Matrix

This matrix helps you understand:

•	 What should be done

•	 What should be planned

•	 What should be resisted

•	 What should be rejected
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The simplest method of managing time is to create a general to do list. Prioritize the task list:

•	 A daily list of things to do, numbered in the order of their priority

•	 Start with the most unpleasant and difficult task first latter will completed easily and quickly.

•	 Map out everything while making a task list

•	 Learn to say “No” to unimportant things

•	 Strikeout the things completed so that you are familiar what have been completed and what needs to be 
completed.

List down the routine activities that you perform in a day.

……………………………………………………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………………………………………………… 

…………………………………………………………………………………………………………………………………………………………………………… 

…………………………………………………………………………………………………………………………………………………………………………… 

Prioritize the above mentioned activities in the following heads.

/ŵportant daƐkƐ hniŵportant daƐkƐ hrŐĞnt daƐkƐ Eot hrŐĞnt daƐkƐ
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ϲ͘ϴ͘ϭ /ntrodƵction

hE/d ϲ͘ϴ͗ ZĞƐƵŵĞ PrĞparation

At the end of this unit, you will be able to:

1. Understand the importance of resume.

2. Learn how to prepare a resume.

U n it KbũĞctiǀĞƐ 

A resume is a self-declaration which once done properly shows 
how an individual’s skills, experience and achievements matches 
the need of the work that they wish to get. The sole purpose of a 
resume is one to win an interview. It convinces the future employer 
what he wants from the prospective employee in new career or 
position.

It also establishes an individual as a professional person with 
high standards and excellent writing skills based on the fact that 
his resume is written well. It also helps you clarify your direction, 
qualifications and strengths, boost your confidence or to start out  
the process of committing to a job or a career modification.
One must know about a resume that: 

•	 Your resume is an instrument to get you an interview but not a job

•	 Employer will be screen your resume for just 15-20 seconds. That’s the time your resume will make an 
impact on employer. 

There are different sections on the resume in the same order as mentioned under: 

  
 

  
 

 
 

  
 

Fig.6.8.2: Different Sections on the Resume

Fig.6.8.1: A Resume
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ϲ͘ϴ͘ϭ͘ϭ ZĞƐƵŵĞ HĞadĞr

ϲ͘ϴ͘ϭ͘Ϯ &raŵinŐ tŚĞ KbũĞctiǀĞ

PrĞparation ǁork and iŵportant tipƐ

Before you start preparing your resume make sure to follow the checklist:

•	 Educational documents from class ten onwards to calculate scores

•	 Make list of all things that you need to add to your resume. Like internships, projects, part time jobs, 
extracurricular activities, sports, training, skills, interests etc.  the list doesn't need to be complete, you'll 
always add to the list as you go.

�ĞĨorĞ prĞparinŐ rĞƐƵŵĞ aůǁaǇƐ rĞŵĞŵbĞr͗

•	 Every point in your resume should be specific and must be supported be supported by a number of factual 
information.

•	 Use action verbs in all your points. They catch attention immediately and make your sentences clear.

•	 Use bullets not paragraphs.

•	 Do not mention your responsibilities mention what you have accomplished.

•	 A common mistake we make while constructing the resume is to copy the format from our friends resume 
and built it based on that.

PƵrpoƐĞ͗ You have to provide some information about yourself, so that the employer can reach you. 

DandatorǇ ĮĞůdƐ incůƵdĞ͗ Name, current address, email id, phone number, date of birth. Your name should be 
written in bigger font.

D o N ot:

•	 Include your photo.

•	 Write  RESUME as heading to the file.

•	 Give details like family information, marital status, etc. 

•	 Add these details to the bottom of your resume or occupy more space to fill up these details.

PƵrpoƐĞ͗ To convey the employer what goals you have. The focus should be towards getting a particular position 
in a specific industry.

�ůǁaǇƐ rĞŵĞŵbĞr͗ 

Your objective should include the following:

•	 Position wanted 

•	 Functional area
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•	 Industry wanted

•	 Be specific and restrict it to minimum words.

•	 You objective should be different to each role you apply to

•	 While writing the objective, keep the employers requirement in mind. The objective is not what you desire 
from the company, it’s about company’s need.

ϲ͘ϴ͘ϭ͘ϯ �dƵcation

ϲ͘ϴ͘ϭ͘ϰ ProũĞctƐ and /ntĞrnƐŚipƐ

The next session in your resume is to highlight your educational qualifications. 

PƵrpoƐĞ͗ For the employer to know whether you have basic qualification for the job for which you are applying 
or not.

�ůǁaǇƐ ZĞŵĞŵbĞr͗

•	 To write all educational qualifications from class 10 to highest education.

•	 For class 10 and 12 – include school/college name, Board, Stream/Specialization (If any), year of study, Marks.

•	 For undergraduate – include College name, University name, Degree and Specialization, year of study.

•	 Write all your qualifications in reverse chronological order, i.e. the latest qualification on top.

•	 You may write the educational qualifications in a tabular format or in a simple one after the other order. 

The next part of your resume includes the hands on work that you have done, like projects, internships, in-plant 
training, part time jobs, volunteering, starting up a company and other initiatives. The number and the nature of 
initiatives taken defines whether to keep one heading or detail them under different headings.

PƵrpoƐĞ͗ This is a mandatory part of a resume, as your hands on work and the initiatives you have taken apart 
from your curriculum in what will reflect your real strength as well as separate your resume from your peers. 

ZĞŵĞŵbĞr͗ 

•	 The heading should be – title / project name, role, company/organization name, -2 lines description about 
the specific time period.

•	 Time period is must.

•	 The entries under each heading must be in reverse chronological order.

•	 Be very specific on what you have accomplished. Add numbers and facts wherever possible.

D o N ot:

•	 Do not write simple statements. It does not give employer a clear picture of the work you have done. Thus 
the employer can assume that you have done an internship for the certificate.
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ϲ͘ϴ͘ϭ͘ϱ ^kiůůƐ

ϲ͘ϴ͘ϭ͘ϲ /ntĞrĞƐtƐ

ϲ͘ϴ͘ϭ͘ϳ ZĞĨĞrĞncĞƐ

HĞadinŐ͗ You can have multiple headings under skills. Common heading can include:

•	 ^oŌ ^kiůůƐ͗ must include, they showcase your personality traits. 

•	 �orĞ ƐkiůůƐ͗ If you possess any core skills which differentiates you from others include them. These are skills 
you possess should be relevant to the employer. 

•	 /d ^kiůůƐ͗ These days every job needs IT skills so mention all the skills that you have. Any software that you 
have worked on or even basic IT skills.

ZĞŵĞŵbĞr͗

•	 Pick only a few soft skills that best represents you

•	 Give relevant examples if possible for the skills that you have mentioned. 

Provide relevant interests that you would like your employers to know. 

This section will define you as an individual and informal discussions will be centered on this topic. These 
discussions will normally be used to understand your core values, communication skills and your interests. 

ZĞŵĞŵbĞr͗ 

•	 provide details of those interests that makes sense and which adds value to you

•	 Make points specific and add supporting fact to it.

•	 Do not just list random interests like: sleeping, eating, breathing etc.

•	 Do not include interests like Smoking, drinking, partying movies etc. they create wrong impression.

ZĞĨĞrĞncĞƐ in tŚĞ rĞƐƵŵĞ

References are people whom you have worked with you before or who know you and are in senior positions 
in their organizations. The references may be called upon to ask about you. While providing the details of the 
references remember to

•	 Provide the name, email ID, Phone number (after taking the approval from the reference), and the relationship 
with you.  

•	 Ensure that you have spoken to the reference and tell them that they should expect a call from your potential 
ployers.  
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ϲ͘ϴ͘ϭ͘ϴ PointƐ to ZĞŵĞŵbĞr
•	 The resume should not be verbose and should be limited to 2 pages

•	 Resume should not have any errors on it. No spelling mistakes, no grammatical errors etc. 

•	 Go through your resume multiple times to get the resume right. You might need to continuously edit it. 

•	 Keep the font professional and at 11 or 12. Do not use more than 2 fonts. Ideally limit it to one. 

•	 However the font of the header and the introduction can have a font that is bigger.

•	 The text should all be in black as most employers print in black and white. 

•	 Keep enough margin on the sides and the top (1.5 to 2 line space) 

•	 The body of the resume should be left aligned and the header should be center aligned. 
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ϲ͘ϵ͘ϭ /ntĞrǀiĞǁ

hE/d ϲ͘ϵ͗ /ntĞrǀiĞǁ PrĞparation

By the end of this unit, you will:

1. Understand the procedure of interview.

2. Go thorough mock interviews.

3. Understand how to present themselves during an interview.

4. Be motivated to work after the training period is over.

U n it KbũĞctiǀĞƐ 

A conversation between two people (interviewer and interviewee) where the questions are asked by the 
interviewer to the interviewee with the intent of understanding the interviewee is an interview.  Essentially in 
simple terms if you are looking for a job then you get interviewed by the employer who checks your knowledge, 
skills, interests etc. 

^oŵĞ tǇpĞƐ oĨ /ntĞrǀiĞǁ

1. HZ /ntĞrǀiĞǁ͗ Traditionally interviews are face to face interviews. Normally it’s a one-to-one conversation 
with the HR Executive. You are advised to maintain good eye contact, listen keenly and answer promptly.

2. PanĞů /ntĞrǀiĞǁ͗ In this situation, there is more than one interviewer. A panel ranging from two to ten 
members discuss and interview. In this case you can display group management and group presentation 
skills.

3. dĞcŚnicaů intĞrǀiĞǁ͗ Based on your skills and the requirements of the organization a technical interview is 
conducted. The focus is on the skill set based on what’s on the resume or the organizations need. 

4. dĞůĞpŚonic /ntĞrǀiĞǁ͗ In cases where the candidate cannot reach the interview physically an interview on 
the telephone is conducted. This is normally the first screening interview. 

Before going for an interview, it is important to have clarity of the role you are applying for. It’s also important 
that for you to know where you are applying and whom will you be talking to. Your answers should tell the 
employer that you are the match they are looking for. 

Fig.6.9.1: Interview
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This requires you to do a small research on the following fields:

•	 Company & Field

•	 Job Description

•	 Yourself (Skills, Values & Interests)

•	 Resume (Experience)

If you were an employer, you would have chosen a person who is sure of himself, calm and confident. So it’s 
important that you are:

•	 Confident

•	 Relaxed

•	 Sure of yourself

•	 Prepared

•	 Dress Professionally

It is important that you dress professionally. It is a proven fact that the way we dress makes a huge difference 
in the way we are perceived. 90% of the way you communicate with other people is through body language 
(gestures, expressions, etc.) and the first Impression we make. It is very simple to make a great first impression.

For a good first impression it is important those we:

•	 Smell good

•	 Have a professional appearance

•	 Pay attention to your grooming

•	 Make eye contact

•	 Know what and how you speak

•	 Our overall personality contributes to our complete perception.

Hoǁ to drĞƐƐ Ĩor /ntĞrǀiĞǁ

DĞn toŵĞn

Long-sleeved buttoned shirt (clean and pressed) Conservative pump, no stilettos

Dark shoes (cleaned and polished) and dark socks Jewellery -One set of earrings (preferably knobs)

Get a haircut (short hair is always best) No bangles

No Jewellery (chains, earrings, piercing) Minimal use of makeup

No beards or Tattoos

Fig.6.9.2: Dress for Interview
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ϲ͘ϵ͘Ϯ dŚĞ �o͛Ɛ and �on͛tƐ in an /ntĞrǀiĞǁ

ϲ͘ϵ͘ϯ �ƵrinŐ tŚĞ /ntĞrǀiĞǁ

Some of you might have faced an interview and some of you might not have. However, by now, you definitely 
have a better understanding what are the accepted standards of a professional behavior. Read the sentences 
given and mark them as do’s or don’ts, in relation to an interview:

^ĞntĞncĞ �o͛Ɛ �on͛tƐ
Be yourself
Burp while talking!!!
Just out from a ‘powder factory’ ( worn too much make-up)
Reach just about the right time for the interview
Just barge in the cabin/ office
Forget to greet the receptionist/ don’t respond
Think before you speak
Do your homework- Visit the company website
Take time to think (TTTT)
Wear bright colour clothes on the D-day
Emphasis on your strengths
Argue/ Debate with the interviewer
Chew gum during the interview.
Review your educational and work experiences
See your documents flying out of the file (Being clumsy)
Thank the interviewer
Have the ‘they need me’ attitude
Maintain eye contact and good body language
Only give monosyllabic answers(depends on the kind of questions asked…in-
between)
Carry a copy of your resume

Fig.6.9.3: Do’s and Don’ts in an Interview

•	 Be confident, not arrogant

•	 Sell yourself - Keep your energy up

•	 Maintain your posture

•	 Be positive, don’t complain

•	 Know your resume and accomplishments.

You need to express effectively in an interview. The parameters that the candidates are assessed on during the 
interview are very simple. These are the parameters that this training program has prepared you for.
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